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1
메뉴 설명 및 기본 옵션

1. 화면의 구성

Project

Manager

메뉴

툴바

작업창

툴팔레트

Session 

Log

2. 기본 메뉴 및 아이콘, 툴바

1) 메뉴

 ① ② ③   ④  ⑤   ⑥    ⑦     ⑧    ⑨   
① File : 파일을 열거나 저장하고 Schematic을 인쇄함

② Edit : 작업도면에서 아이템을 변경하거나 삭제함

③ View : 작업도면의 축척도를 바꾸거나 다시 그림

④ Place : 부품 가져오기 또는 그리기

⑤ Macro : 매크로 기능 작성
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⑥ PSpice : OrCAD PSpice에 의한 시뮬레이션 기능

⑦ Accessories : Alias 로테이션 기능

⑧ Options : 화면과 환경 셋업

⑨ Window : 윈도우 선택 및 정렬방식

 Help : 도움말

2) 툴바

①  ②  ③  ④  ⑤  ⑥  ⑦  ⑧  ⑨                               ㉖
① New : 새로운 설계 및 라이브러리 작성

② Open : 기존 설계 및 라이브러리 열기

③ Save : 작업도면 또는 부품을 저장

④ Print : 작업도면 또는 부품을 인쇄

⑤ Cut : 선택한 개체를 삭제하고 클립보드에 저장

⑥ Copy : 선택한 개체를 클립보드에 저장

⑦ Paste : 클립보드에 저장되어 있는 내용을 문서에 붙임

⑧ Undo : 가장 최근에 실행한 명령을 취소

⑨ Redo : 가장 최근에 실행한 명령을 다시 실행

 Place Part : 최근에 사용했던 부품 목록

 Zoom in : 한번 클릭할 때마다 작업도면 2배씩 확대

 Zoom out : 한번 클릭할 때마다 작업도면 1/2씩 축소

 Zoom to region : 작업도면에서 드래그 하여 지정한 영역을 확대

 Zoom to all : 모든 개체가 한 화면에 보이게 함

 Fisheye view :　부분 확대

 Annotate : 작업도면상에서 부품의 참조를 갱신

 Back annotate : PCB 쪽 수정정보를 작업도면에서 갱신

 Design rules Check : 도면의 설계 오류를 체크

 Create netlist : 부품과 부품의 연결　상태 정보를 생성

 Cross reference parts : 교차 참조된 부품 목록을 작성

 Bill of material : 부품 목록서 작성

 Snap To grid : 부품을 그리드에 맞추어 이동

 Area Select : 부품 선택　시 전체 또는 부분 선택 가능

 Drag connected object : 부품과 부품 또는 연결선의 단선 방지

 Project manager : 프로젝트 매니저　창 선택

㉖ Help : 도움말

3) 시뮬레이션 툴바

    　 　 ①       ② 　 ③ 　 ④ ⑤  ⑥ 　 ⑦ ⑧ 　 ⑨  　 　  　 
① Active Profile : 작업 중인 프로파일 목록
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② New Simulation Profile : 프로파일 생성

③ Edit Simulation Settings : 현재 프로파일 편집

④ Run PSpice : 시뮬레이션 실행

⑤ View Simulation Results : 시뮬레이션 결과 보기

⑥ Voltage/Level Marker : 전압 표시자

⑦ Voltage Differential Marker(s) : 양단간 전압 표시자

⑧ Current Marker : 전류 표시자

⑨ Power Dissipation Marker : 소비전력 표시자

 Enable Bias Voltage Display : 직류 전압 표시자

 Toggle Voltages On Selected Net(s) : 선택된 네트만 전압 표시 토글

 Enable Bias Current Display : 직류 전류 표시자

 Toggle Currents On Selected Part(s)/Pin(s) : 선택된 부품/핀만 전류 표시 토글

 Enable Bias Power Display : 직류 전력 표시자

 Toggle Power On Selected Part(s) : 선택된 부품만 전력 표시 토글

4) 툴팔레트

① ②  ③ ④  ⑤ ⑥ ⑦ ⑧ ⑨              ㉑ ㉒ ㉓ ㉔ ㉕ ㉖ ㉗
① Select : 개체 선택

② Place part : 부품 선택 배치 

(Pspice 라이브러리의 경로 : C:\Cadence\SPB_16.3\tools\capture\library\pspice)

③ Place wire : 부품 간 연결선

④ Place Auto wire Two Points : 두 포인터를 자동으로 연결

⑤ Place Auto wire Multi Points : 여러 개의 포인터를 자동으로 연결

⑥ Place Auto wire Connect to Bus : Bus와 자동으로 연결

⑦ Place net alias : 네트에 이름 정의 (%, &, ^, @, ~, * 등 특수문자 사용불가)

⑧ Place bus : 버스선 연결(예 : “Q[0:3]", "Q[0-3] 등)

⑨ Place junction : 접합점 놓기

⑩ Place bus entry : 버스와 와이어간 연결 인입선

⑪ Place power : 전원 심볼 배치

⑫ Place ground : 접지 심볼 배치 (‘ ’심볼 배치)

⑬ Place hierarchical block : 계층 블록 생성

⑭ Place port : 포트 단자 배치

⑮ Place pin : 계층 블록 핀 배치

⑯ Place off-page connector : 페이지 간 연결 심볼

⑰ Place no connect : 핀에 연결 없음 표시

⑱ Place line : 라인 배치

⑲ Place polyline : 폴리라인 배치

⑳ Place rectangle : 사각형 배치

㉑ Place ellipse : 타원 배치
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㉒ Place arc : 호 배치

㉓ Place Elliptical Arc : 타원형의 호 배치

㉔ Place Bezier Curve : Bezier 곡선 배치

㉕ Place text : 텍스트 배치

㉖ Place IEEE symbol : IEEE 심볼 표시

㉗ Place pin array : 핀 배열

3. Simulation Settings Tab

(1) General

① Simulation Profile: 시뮬레이션 설정 파일명

② Input : 프로젝트에 관련된 입력 파일 관련 사항 표시

③ Output : PSpice 출력 파일 관련 사항 표시

④ Notes : Simulation Setting에 관하여 사용자가 나타내고 싶은 사항 입력

(2) Analysis

1) Time Domain 2) DC Sweep

3) AC Sweep/Noise 4) Bias Point
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(3) Configuration Files

시뮬레이션 수행 시 Stimulus/Library/Include 할 파일을 선택하거나 직접 입력한다. Add as 

Global은 PSpice 해석을 수행하는 모든 파일에 적용하며, Add to Design은 선택한 설계회

로에만 적용된다. 

- Stimulus : 이전에 작업한 소스원 (VSTIM 등을 사용하여 만든 전압원 또는 전류원)

을 사용할 경우 Browse를 통해 경로를 설정한다.

- Library : 새로운 라이브러리 파일을 만든 경우 Browse를 통해 경로를 설정한다.

- Include : 라이브러리 파일에서 변수 명을 지정하여 라이브러리를 만든 경우 변수 

명에 대한 값을 파일로 저장하여 경로를 설정한다.

Include tab, Library tab, Stimulus tab에는 내장되어 있는 source 및 library를 사용할 때 또

는, 내장되어 있는 라이브러리 및 Source를 편집할 경우에는 자동적으로 편집된 내용이 파

일로 저장되게 되어 있다. 그래서 따로 지정할 필요가 없지만, 새롭게 사용하여야 할 라이브

러리 및 다른 프로젝트에 Save As된 Source를 이용하여야 할 경우 위의 환경 창에 새로운

(편집된) 파일을 링크하여야만 사용할 수 있다.

※ Tip  위에서 다루어진 Include tab, Library tab, stimulus tab에는 기본적으로 자체 프로젝트에서는 자동

적으로 지정된다. 그러나 라이브러리 탭의 관점에서 새로운 라이브러리를 생성할 경우 또는 Model Editor

에서 기존의 소자의 특성만 복사에서 다른 이름으로 사용할 경우 시뮬레이션 설정창의 라이브러리 탭에서 

새로운 라이브러리를 시뮬레이션에 포함하도록 경로를 지정한다. 새로운 모델을 만들고 시뮬레이션 시 라

이브러리 탭에 모델이 들어 있는 라이브러리를 추가하지 않을 경우 다음과 같은 에러가 발생한다. 

“ERROR -- Subcircuit  kkk used by X_halfadd_A_U4 is undefined"

Stimulus tab의 사용도 마찬가지로 다른 프로젝트에서 사용된 파형을 불러와 사용할 경우 해당 tab에서 경

로를 지정해야 한다. 하나의 *.stl에 여러 개의 다른 이름의 입력파형도 지정할 수 있고 이 *.stl을 지정하여 

schematic에서 이름만 주어지면 된다.
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(4) Options

PSpice에서는 여러 가지 해석에 대한 시뮬레이션 계산을 위한 파라미터를 제한하고 설정하

는 여러 가지 조건을 제공하고 있다. 시뮬레이션 해석 후에 결과를 저장하는 output 파일에 

시뮬레이션에 대한 어떤 정보를 저장하느냐의 여부에 대해 선택을 하는 것이고, 수치를 입

력하는 options는 시뮬레이션의 결과에 대한 정확도와 해석 알고리즘의 계산, 스텝사이즈 

및 반복계산 횟수를 결정하는 역할을 수행한다. 회로가 복잡해지거나 반도체 소자를 시뮬레

이션에 사용하게 되면 해석에러(Convergence Error)가 종종 발생하가나 해석 시간이 상당히 

오래 걸리는 경우가 발생하게 되는데 이때는 수치를 입력하는 options 값을 변경하여 이를 

피할 수 있다. Options는 Analog Simulation, Gate-level Simulation, Output file Category로 

구분된다.

  

1) Analog Simulation Options

PSpice의 결과에 대한 정확도는 값을 입력하는 Options 중에서 RELTOL, VNTOL, ABSTOL, 

CHGTOL의 설정에 의해 좌우된다. 그 중에서도 계산되는 모든 전압, 전류에 대한 상대적인 

정확도를 결정하는 RELTOL이 가장 중요한 변수인데 0.001(0.1%)이 default 값이다.

VNTOL, ABSTOL, CHGTOL은 각각 전압, 전류, 전하/자속에 대한 가장 좋은 정확도를 의미하

며 RETOL과 다음의 관계식에 의해 정확도가 결정된다.
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Options Default 의      미
RELTOL 0.001 전압과 전류의 상대적 accuracy
VNTOL 1uV 최소 전압 제한치
ABSTOL 1pA 최소 전류 계산치
CHGTOL 0.01pC 최소 전하 계산치
GMIN 1p 최소 컨덕턴스
ITL1 40 DC and bias point “blind” iteration limit
ITL2 20 DC and bias point “best guess" iteration limit
ITL4 10 과도해석 시의 반복 제한치

TNOM 27 기본온도
STEPGMIN 개선된 Convergence GMIN 사용
PREORDER Matrix Fill-In 삭감을 위한 Preorder 사용

Voltage Accuracy default = MAX(0.1% of voltage, 1uV)

Current Accuracy default = MAX(0.1% of current, 1pA)

Charge Accuracy default = MAX(0.1% of charge, 0.01pC)

Flux Accuracy default = MAX(0.1% of flux, 0.1Weber/m2)

PSpice에서 제공하는 default 값을 가지고 계산할 경우에는 다음과 같다.

위의 수식에서 알 수 있듯이 PSpice의 계산에서 가장 문제가 되는 곳은 전압이나 전류가 부

호를 바꾸는 영(zero)부분의 계산인데 이곳의 계산시간이 시뮬레이션 전체 시간의 대부분을 

차지하며 convergence error가 가장 많이 발생한다. 일반적으로 PSpice에서는 12차의 크기

를 사용하는데 만일 kA 단위의 전류를 시뮬레이션 할 때 RELTOL=0.01%, ABSTOL=1pA를 

선택할 경우 kA 단위가 1pA의 12차 이상이 됨으로 convergence error가 발생할 소지가 있

다. 따라서 전압이나 전류의 Order에 따라 ABSTOL과 VNTOL을 조절할 필요가 있다.

예)  ABSTOL = 1uA ; kiloampere range

     ABSTOL = 1mA ; megaampere range

     VNTOL = 1uV ; kilovolt range

대부분의 경우 RETOL=0.001(0.1%)을 선택하면 필요이상 정확한 해석을 수행하는 것으로 시

뮬레이션을 좀 더 빨리 수행하려면 RELTOL=0.01(1%) 혹은 RELTOL=0.005(0.5%)를 선택한다. 

RELTOL=0.01(1%) 이상 입력하는 것은 시뮬레이션 결과에 오류가 발생할 경우가 있기 때문

에 그 이상 입력하지 않도록 주의해야 한다.

▶ MOSFET Options

Options Default 의      미
DEFAD 0 MOSFET default drain area(AD)
DEFAS 0 MOSFET default source area(AS)
DEFL 100.00u MOSFET default length(L)
DEFW 100.00u MOSFET default width(W)

▶ Advanced Analog Options

Options Default 의      미
ITL5 0 Total iteration limit (0=무한대)

PIVREL 1.0E-3 matrix solution을 pivot하기 위한 상대적 크기
PIVTOL 1.0E-13 matrix solution을 pivot하기 위한 절대적 크기
SOLVER default 시뮬레이션 알고리즘

DMFACTOR 1 최소 delta의 상대적 요소
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2) Gate-Level Simulation Options

  

◆ Timing Mode : 최악(Worst-case)의 경우를 가상하여 timing 시뮬레이션을 설정한다. 

Digital Setup 대화상자에서 설정하지 않고 각 소자의 circuit-wide delay 

mode를 직접 재설정할 수 있도록 propagation delay mode를 설정할 수 

있다. 각 소자의 Minimum, Typical, Maximum, Worst-Case 등으로 설정

할 수 있다.

◆ Initialize all flip-flops : 플립플롭의 초기 값을 설정한다. 초기 값을 ‘X’로 설정하면 모든 

플립플롭은 set이나 reset 할 때까지 unknown 상태를 유지한다. 초기 값

을 ‘0’로 설정하면 모든 플립플롭은 ‘0’으로 설정되며, 초기 값을 ‘1’로 설

정하면 모든 플립플롭은 ‘1’로 설정된다.

◆ Default I/O level for A/D interface : 아날로그와 디지털 회로가 혼합되어 있는 혼합 신

호 시뮬레이션을 실행할 때 회로 전체와 각 소자 인스턴스에 대한 AtoD

와 DtoA Subcircuit의 인터페이스 레벨을 선택한다. AtoD와 DtoA의 

Subcircuit 인터페이스는 아날로그 전압/임피던스의 정보를 디지털 상태의 

정보로 변환하거나 그 반대의 변환을 나타내어야 하며, 이것을 4가지 레

벨로 나누어 설정한다. 레벨 1과 레벨 2의 차이점은 다음과 같다. 레벨 1

에서는 전압 범위 VILMAX와 VIHMIN 사이에 중간 논리 상태인 R, F, X 

상태를 발생하는 것이며, 레벨 2에서는 중간 논리 상태인 R, F, X 상태를 

발생하지 않고 직접 ‘0’과 ‘1’ 또는 ‘1’과 ‘0’의 변환을 나타낸다. 레벨 3과 

레벨 4는 레벨 1과 레벨 2와 각각 같으며, 나중에 사용을 위해 준비된 것

이다.

▶ Advanced Gate-level Simulation Options

Options Default 의      미
DIGDRVF 2 최소 드라이브 저항(디지털)
DIGDRVZ 20K 최대 드라이브 저항(디지털)

DIGOVRDRV 3 드라이브 저항의 비
DIGMNTYSCALE 0.4 typical delay로부터 minimum delay를 유도하는데 사용하는 scale factor
DIGTYMXSCALE 1.6 typical delay로부터 maximum delay를 유도하는데 사용하는 scale factor
DIGERRDEFAULT 20 디지털 constraint 소자에 대한 에러 제한치

DIGERRLIMIT 0 최대 디지털 에러 메시지 제한치
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3) Output File Options

Options 의      미
ACCT 모든 해석 후 정보의 요약 및 accounting information을 output 파일에 저장
EXPAND Subcircuit 확장에 의해 생성된 소자를 나열한다.
LIBRARY 사용한 library 파일을 나열한다.
LIST 사용한 소자를 나열한다.
NOBIAS 바이어스 포인터 계산 결과를 표시하지 않는다.
NODE 노드 연결 상태 정보를 표시한다.
NOECHO 입력파일을 표시하지 않는다.
NOMOD 모델 파라미터 및 온도를 표시하지 않는다.
NOOUTMSG 시뮬레이션 조건을 표시하지 않는다.
NOPAGE Output 파일의 주요 부분에 banner를 표시하지 않는다.
OPTS 모든 options 값을 표시한다.
NUMDG Digit Display 비트 수

(5) Data Collection

회로도에서 수집할 데이터 종류 선택. Voltages, Currents, Power, Digital, Noise

- At Markers Only : Marker에 의해 Schematics 화면상에 표시한 노드 데이터만을 저장한다.

- All : 전체회로에 대한 모든 데이터 저장

- All But Internal Subcircuit : Subcircuit 안쪽에 존재하는 노드를 제외한 모든 노드 데이터 저장

- None : 데이터를 저장하지 않음

- Save data in the CSDF Format [.CSD] : Probe용 데이터를 binary대신 Text format으로 저장
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(6) Probe Window

◆ Display Probe window when profile is opened : Profile을 open할 때 Probe window를 

표시한다.

◆ Display Probe window

‣ during simulation : 시뮬레이션이 진행되는 동안 probe window를 표시한다.

‣ after simulation has completed : 시뮬레이션이 끝난 후에 probe window를 

표시한다.

◆ Show

‣ All Markers on open schematics : Schematics 화면상에 표시한 모든 marker

의 전압, 전류를 자동으로 probe 화면에 표시한다.

‣ Last plot : 자동적으로 가장 최근의 probe session을 재설정한다.

‣ Nothing : 어떤 파형도 probe 화면에 표시하지 않는다.

4. SPICE 명령어

형 식 해석 형태 도트 명령어 비 고

Standard
Analysis

DC Sweep .DC DC Sweep
Bias Point Detail .OP Bias Point
Transfer Function .TF Small-Signal Transfer
Sensitivity .SENS DC Sensitivity
AC Sweep .AC Frequency Response
AC Sweep/Noise .NOISE Noise
Transient .TRAN Transient
Transient/Fourier .FOUR Fourier Components

Simple Multi-Run
Analysis

Parametric .STEP Parametric
Temperature .TEMP Temperature

Statistical
Analysis

Monte Carlo .MC Monte Carlo
Worst Case .WCASE Sensitivity/Worst-Case

General
Setup

Save Bias Point .SAVEBIAS Store Unclamped Bias Point
Load Bias Point .LOADBIAS Restore Unclamped Bias Point
Options .OPTIONS Set Miscellaneous

* 도트 명령어의 경우 TEXT로 회로를 작성하고 시뮬레이션을 할 경우
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단축키  

All Capture Windows

Key Mouse click equivalent

ALT+F4 Exit

ALT, F, X Exit

ALT, SPACEBAR, C Exit

F1 Help

Ctrl + F8
Switch Capture to Full Screen mode (Click Close Full Screen 

button or press Escape key to exit Full Screen mode)

Schematic page editor

Key Mouse click equivalent

CTRL+A Select All

A Ascend hierarchy

D Descend hierarchy

B Place bus

E Place bus entry

F Place power

G Place ground

J Place junction

N Place net alias

P Place part

T Place text

W Place wire

Y Place polyline

X Place No connect symbol

F7 Record macro

F8 Play macro

F9 Configure macro

CTRL+SHIFT+A Add part(s) to group

CTRL+SHIFT+R Remove part(s) from group

CTRL+I

Opens the Selection Filter dialog box where you can 

specify the objects that should be selected when the 

mouse pointer is dragged diagonally across the schematic 

page.

CTRL+SHIFT+Left Click Lock component
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Schematic page and part editors

Key Mouse click equivalent

CTRL+C Copy

CTRL+E Edit properties

CTRL+F Find

CTRL+G Go to

CTRL+P Print

CTRL+S Save

CTRL+T
Cursor snap to grid (identical to the Preferences dialog box 

Grid display tab option).

CTRL+V Paste

CTRL+X Cut

CTRL+Y Redo

CTRL+Z Undo

F4 Repeat

DEL Delete (Design and Edit menus)

DELETE Delete (Design and Edit menus)

BACKSPACE Delete (Design and Edit menus)

ENTER Double-click left mouse button

ESCAPE Deselect all and switch to selection tool (arrow pointer)

SPACE Click left mouse button

UP ARROW Move 1 grid up (grid on) or 0.1 grid up (grid off)

DOWN ARROW Move 1 grid down (grid on) or 0.1 grid down (grid off)

LEFT ARROW Move 1 grid left (grid on) or 0.1 grid left (grid off)

RIGHT ARROW Move 1 grid right (grid on) or 0.1 grid right (grid off)

CTRL+UP ARROW Snap pointer to nearest grid and then move 5 grids up

CTRL+DOWN ARROW Snap pointer to nearest grid and then move 5 grids down

CTRL+LEFT ARROW Snap pointer to nearest grid and then move 5 grids left

CTRL+RIGHT ARROW Snap pointer to nearest grid and then move 5 grids right

PAGE UP Pan up

PAGE DOWN Pan down

CTRL+PAGE UP Pan left

CTRL+PAGE DOWN Pan right

F5 Redraw

C Center the view at the pointer's current position

H Mirror horizontally

I Zoom in

O Zoom out

R Rotate
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2
Probe 윈도우 활용

1. Probe Window 구성

Display

Trace

Legend

Toolbar

Menu

2. 메뉴 및 툴바 구성

1) 메뉴

  ① ② ③    ④   ⑤  ⑥  ⑦  ⑧   ⑨ 
① File : Probe 파일 관리

② Edit : Probe 파일 편집

③ View : 화면 줌, 툴바, 회로/출력/시뮬레이션 파일 보기

④ Simulation : 시뮬레이션 Run, Stop

⑤ Trace : 트레이스(파형곡선) 추가, 삭제
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⑥ Plot : X-Y 축 지정, 화면 분할, 라벨

⑦ Tools : 메뉴 바, 툴바 조정

⑧ Window : 출력화면 정렬, 클립보드 복사

⑨ Help : 도움말

 Alternate Display : Probe 화면만 보이는 창으로 토글

2) 툴바

 ①  ②③ ④⑤  ⑥⑦⑧  ⑨                         
① New : 새로운 시뮬레이션 프로파일 및 텍스트 파일 생성

② Open : 새로운 Probe Data Plot 윈도우 열기

③ Append File : 현재의 Plot 윈도우에 다른 Probe 데이터 첨부

④ Save : 현재 윈도우의 Probe Data 저장

⑤ Print : Plot 윈도우 화면 인쇄

⑥ Cut : 선택 항목 잘라내기

⑦ Copy : 선택 항목 복사

⑧ Paste : 클립보드 내용 붙여넣기

⑨ Undo : 최근 실행 작업 취소

 Redo : 최근 실행한 Undo 취소

 Current Simulation : 현재 작업 중인 시뮬레이션 프로파일

 Run For : 원하는 시간까지 시뮬레이션 진행

 Run PSpice : 시뮬레이션 실행

 Save Simulation State : 현재 시뮬레이션 상태 저장

 Pause : 시뮬레이션 일시정지

①  ②  ③ ④  ⑤   ⑥  ⑦ ⑧  ⑨                     
① Zoom In : 화면 확대

② Zoom Out : 화면 축소

③ Zoom Area : 일정영역 확대/축소

④ Zoom Fit : 전체보기

⑤ Load Next Part : 다음 Part 불러오기

⑥ Toggle Large Data File Mode : 대형 데이터 파일모드 표시 토글

⑦ Log X Axis : X축 Log 스케일 지정

⑧ Fourier : 퓨리에 변환

⑨ Performance Analysis : 성능분석 실행

 Log Y Axis : Y축 Log 스케일 지정

 Add Trace : Trace 추가

 Evaluate Measurement : 내장함수로 측정평가

 Text Label : 텍스트 라벨 추가
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 Mark Data Points : 데이터 포인트 표시

 Toggle cursor : Cursor Probe 창 표시 토글

 Cursor Peak : 다음 Peak로 커서 이동

 Cursor Trough : 다음 Trough로 커서 이동

 Cursor Slope : 최대 경사 포인트로 커서 이동(변곡점)

 Cursor Min : 최소 포인트로 커서 이동

 Cursor Max : 최대 포인트로 커서 이동

 Cursor Point : 다음 데이터 포인트로 커서 이동

 Cursor Search : 명령에 의한 데이터 포인트 지점으로 커서 이동

 Cursor Next Tran : 디지털회로에서 다음 Transition으로 커서 이동

 Cursor Prev Tran : 디지털회로에서 이전 Transition으로 커서 이동

 Mark Label : 현 커서 포인트의 값 표시

①  ② ③ ④  ⑤  ⑥

① Always On Top : 항상 최상위로 표시

② View Circuit File : Circuit 파일 표시

③ View Simulation Output File : 시뮬레이션 출력파일 표시

④ View Simulation Results : 시뮬레이션 결과 표시

⑤ Simulation Queue : 시뮬레이션 큐 표시

⑥ Edit Simulation Settings : 시뮬레이션 프로파일 설정 창 표시

3. PSpice A/D에서 사용할 수 있는 함수

아날로그 디지털
함  수 용  도 함  수 용  도
ABS(x)

SGN(x)

SQRT(x)

EXP(x)

LOG(x)

LOG10(x)

M(x)

P(x)

R(x)

IMG(x)

G(x)

PWR(x)

SIN(x)

COS(x)

TAN(x)

ATAN(x)

d(x)

s(x)

AVG(x)

AVGX(x,d)

RMS(x)

절대치

Sign function

Square root

지수함수

자연로그

상용로그

x의 크기

x의 위상(각도)

x의 실수부

x의 허수부

x의 그룹지연시간

Power

사인함수

코사인함수

탄젠트함수

아크탄젠트함수

x의 미분

x의 적분

평균치

d부터 x까지 평균치

실효치

( )

~

*

/

+

-

&

^

|

Grouping

Logical complement

곱셈(버스에만 적용)

나눗셈(버스에만 적용)

덧셈(버스에만 적용)

뺄셈(버스에만 적용)

논리곱

배타적 OR

논리합



2장 Probe 윈도우 활용

나인플러스 EDA (주)                                   18

4. PSpice에서 사용하는 단위

Alphabet used... Stands for.. 

F(f) femto 

P(p) pico 

N(n) nano 

U(u) micro 

M(m) milli 

K(k) kilo 

MEG(meg) mega 

G(g) giga 

T(t) tera 

   

예)

Notations Equivalent to... 

2M2 2.2M 

2MEG2 2.2MEG 

4L5 4.5H(Inductor of 4.5 henry)

2K2 2.2K 

12C2 Capacitor of 12.2 farads 

5R4 Resistor of 5.4 ohms 

2p2 2.2p (2.2*10-12) 

5. Breakout Parts

Use this 
breakout part... 

For this device 
type... 

Which is this 
PSpice device letter... 

BBREAK GaAsFET B 

CBREAK Capacitor C 

DBREAK Diode D 

JBREAK JFET J 

KBREAK Inductor Coupling K 

LBREAK Inductor L 

MBREAK MOSFET M 

QBREAK Bipolar Transistor Q 

RBREAK Resistor R 

SBREAK Voltage-Controlled Switch S 

WBREAK Current-Controlled Switch W 

XFRM_NONLINEAR Transformer K and L 

ZBREAKN IGBT Z 

6. Cursor

1) Toggle Cursor



2장 Probe 윈도우 활용

나인플러스 EDA (주)                                   19

A1 : Cursor1(Left Mouse Button Click),      A2 : Cursor2(Right Mouse Button Click)

Key Combination... To do this with the cursors... 

Ctrl+Left arrow key and 
Ctrl+Right arrow key 

Change the trace associated 
with the first cursor. 

Shift+Ctrl+Left arrow key and 
Shift+Ctrl+Right arrow key 

Change the trace associated with the 
second cursor. 

Left arrow key and Right arrow key Move the first cursor along the trace. 

Shift+Left arrow key and
Shift+Right arrow key 

Move the second cursor along the trace. 

Home 
Move the first cursor to the 
beginning of the trace. 

Shift+Home 
Move the second cursor to the 
beginning of the trace. 

End 
Move the first cursor to the end 
of the trace. 

Shift+End Move the second cursor to the 
end of the trace. 

2) Search Command

Search [direction] [/start_point/] [#consecutive_points#] [(range_x[,range_y])]

[for] [repeat:] <condition>

[direction]

Forward(Default) or Backward

[/start_point/]

^ The first point in the search range

Begin The first point in the search range

$ The last point in the search range

End The last point in the search range

xn
A marked point number or an expression of marked points.
x1 or (x1 - (x2 - x1)/2)
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(1n,200n) X range limited from 1e-9 to 200e-9, Y range defaults to full range

(1.5,20e-9,0,1m) Both X and Y ranges are limited

(5m,1,10%,90%) Both X and Y ranges are limited

(0%,100%,1,3) Full X range, limited Y range

(,,1,3) Full X range, limited Y range

(,30n) X range limited only on upper end

(사용 예)

search forward x value (100)

search backward level (max-3)

[(range_x[,range_y])]

7. Markers

1) 기본 Marker

Volt Marker : Current Marker :

Diff Volt Marker : Power Marker :

2) AC Sweep Marker (AC sweep으로 설정 시에만 사용가능)

메뉴 PSpice → Markers → Advanced

dB Magnitude of Voltage Phase of Voltage

Group Delay of Voltage Real Part of Voltage

Imaginary Part of Voltage
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3) 그 외(메뉴 PSpice → Markers → Plot Window Templates 실행)
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단축키 PSpice shortcut keys

Key Mode or user interface item Function or menu command

CTRL+A Zoom menu (on the View menu) Area

CTRL+C Edit menu Copy

CTRL+SHIFT+C Cursor menu (on the Trace menu) Display

CTRL+F Edit menu Find

CTRL+SHIFT+F Cursor menu (on the Trace menu) Freeze

CTRL+G Edit menu Goto Line

CTRL+H Edit menu Replace

CTRL+I Zoom menu (on the View menu) In

CTRL+SHIFT+I Cursor menu (on the Trace menu) Point

CTRL+L Zoom menu (on the View menu) Redraw

CTRL+SHIFT+L Cursor menu (on the Trace menu) Slope

CTRL+SHIFT+M Cursor menu (on the Trace menu) Min

CTRL+N With a PSpice window active Creates a new text file

CTRL+SHIFT+N Cursor menu (on the Trace menu) Next Transition

CTRL+O File menu Open

CTRL+P File menu Print

CTRL+SHIFT+P Cursor menu (on the Trace menu) Peak

CTRL+SHIFT+R Cursor menu (on the Trace menu) Previous Transition

CTRL+SHIFT+S Cursor menu (on the Trace menu) Search Commands

CTRL+SHIFT+T Cursor menu (on the Trace menu) Trough

CTRL+U With a waveform window active Restores the last deleted traces

CTRL+V Edit menu Paste

CTRL+X Edit menu Cut

CTRL+SHIFT+X Cursor menu (on the Trace menu) Max

CTRL+Y With a waveform window active Add a Y axis

CTRL+SHIFT+Y With a waveform window active Delete a Y axis

F1 Help menu Help Topics

F3 Edit menu Find Next

ALT+F4 File menu Exit

F12 With a waveform window active
Restores the last waveform

window

INSERT With a waveform window active
Opens the Add Traces dialog 

box

DELETE Edit menu Delete

CTRL+DELETE With a waveform window active
Deletes all traces in the 

waveform window
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3
Bias Point 해석

1. Bias Point 해석

바이어스 포인트 계산은 직류분에 대한 정상상태에서의 값을 계산하는 것을 의미하고 어떤 

종류의 해석을 수행할 때도 반드시 먼저 수행되는 해석이다.

이 해석을 선택한 경우

- 모든 아날로그 노드 전압의 리스트

- 모든 디지털 노드의 상태 리스트

- 모든 전압원의 전류와 Power

- 모든 Device의 small signal parameter 리스트를 output file에 출력

2. Simulation Settings

- Include detailed bias point ~(.OP) : 비선형 제어전원이나 반도체 소자를 위한 상세한 바

이어스 포인트 계산 결과를 출력한다.

- Perform Sensitivity analysis(.SENS) : 민감도 해석(Sensitivity analysis)을 수행한다.

Output variable(s): 해석할 출력변수를 입력한다.

- Calculate small-signal DC gain(.TF) : 입, 출력에 대한 전달함수를 계산한다.

From Input source name : 입력 전원을 입력한다.

To Output variable : 출력 변수를 입력한다.
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프로젝트 만들기 

1) 새로운 프로젝트의 시작 (File → New → Project)

2) 프로젝트의 종류

• Analog or Mixed A/D (PSpice)

• PCB

• Programmable Logic

• Schematic

3) 기본 제공 환경

* PSpice Library의 경로

OLB 파일 경로(OLB : 심볼과 관련된 라이브러리)

C:\Cadence\SPB_16.3\tools\capture\library\pspice

LIB 파일 경로(LIB : 부품의 전기적인 특성 정보와 관련된 라이브러리)

C:\Cadence\SPB_16.3\tools\pspice\library
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따라하기

1) 회로도(분압 회로)

2) 사용기능 및 부품

(Place Part)VDC, R, C, (Place Ground)GND, (Place Wire), (Place Net Alias)

3) 시뮬레이션 조건

 

4) Run PSpice

DC gain = -0.5

Source에서 본 임피던스 = 2k

V(R2)에서 본 임피던스 = 0.5k

계산이 완료되면 Output File에 아날로그 노드의 전압과 디지털 노트의 상태를 출력한다.

위 그림에서 각 노드의 전압, 전류, 전력에 대한 결과 값을 확인할 수 있다.
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5) Bias Point Display

  



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과 제  - 전압전류 분배회로

V1
10Vdc

R1

1k

R2
2k

R3
4k

0

Anode

1. Anode의 전압과 전류를 Bias Point 시뮬레이션 하여 조사하시오.

해  설

  

Anode의 전압은 5.714V이고 전류는 이 회로에서 전체 전류와 동일하므로 4.286mA이다.
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4
Time Domain(Transient) 해석

1. 과도(Transient) 해석

과도해석은 시간영역에서 입력신호에 대한 출력을 결정하는 해석을 말한다. 과도 해석의 계

산방법은 항상 L과 C의 현재의 계산 값을 초기치로 하여 다음 스텝의 계산을 수행한다.

2. 퓨리에(Fourier) 해석

FFT는 Probe 상에서 출력 데이터를 가지고 FFT 알고리즘으로 계산하는 것으로 Probe 화

면에 주파수 스펙트럼을 출력하는 기능을 수행하고, 퓨리에 해석은 결과데이터를 퓨리에 적

분하여 결과를 얻는다. 따라서 FFT 결과에서는 단지 크기만이 제공되지만 퓨리에 해석을 

수행할 경우에는 크기, 위상, 직류분 등에 대한 결과를 출력하므로 평균치, 기본파 실효치, 

역률, THD 등을 계산할 수 있다.

3. Simulation Settings

  

- General Settings : Time Domain(Transient)과 관련하여 시간에 대한 회로의 전압, 전류, 

디지털 회로의 논리상태 등의 과도상태를 계산한다.

- Monte Carlo/Worst-Case : 어떤 영역 안에서 모든 소자의 모델 파라미터를 임의로 랜덤

하고 변화시켜 가면서 그 변화에 따른 회로의 응답을 계산한다. 소자의 

오차 범위를 사용자가 설정할 수 있으며, Monte-Carlo 해석을 위해서는 

BREAKOUT의 라이브러리에 있는 소자를 사용하거나 SPECIAL 라이브러

리에 있는 VARIABLES를 사용하여야 한다.

- Parametric Sweep : 전압원, 전류원, 글로벌 파라미터(Global Parameter), 모델 파라미터, 
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전원의 변동, 소자의 값 혹은 동작온도를 정해진 순에서 따라 변화시키

면서 특정한 기본 해석을 반복한다.

- Temperature(Sweep) : 동작온도를 정해진 순서에 따라 변화시켜 가면서 특정한 해석을 반

복한다.

- Save Bias Point : 현재 회로의 바이어스 포인트에 대한 데이터를 파일로 저장한다.

- Load Bias Point : 이전에 계산하여 저장한 바이어스 포인터에 대한 데이터 파일을 Load 

한다.

- Save Check Point : 현재 회로의 체크 포인터에 대한 데이터 파일(정해진 시간 시뮬레이

션 간격이나 시간 간격)을 저장한다.

- Restart Simulation : 이전에 계산하여 저장한 체크 포인터에 대한 데이터 파일을 Load하

여 시뮬레이션 한다.

- Run to time : 시뮬레이션 종료시간을 입력한다.

- Start saving data after : 시뮬레이션 개시 후 데이터를 저장하는 시간을 입력한다.

- Maximum Step size: 과도상태 해석의 수치계산을 위한 최대 step size를 입력한다.

- Skip the initial ~ : 선택할 경우 인덕터, 커패시터 등의 초기치를 무시하고 계산한다.

- Run in resume mode : 시뮬레이션의 재시작 시 Resume 모드로 진행한다. 

- Output File Options... : 출력파일에 저장할 데이터의 시간간격, 퓨리에 해석, 반도체, 비선

형 전원의 바이어스 포인터 데이터의 저장 유무를 선택한다.

- 출력 파일에 저장할 데이터의 시간 간격, 퓨리에 해석의 기본파

주파수, 고조파 차수, 퓨리에 해석할 변수, 반도체 및 비선형 전원

의 바이어스 포인터데이터의 저장유무를 선택한다.
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따라하기

1) 회로도(시정수 찾기)

V1
5V

R1

100k

C1
100u

U1

TOPEN = 50
1 2

U2
TCLOSE = 50

1

2

out

0

2) 사용기능 및 부품

(Place Part)VDC, R, C, sw_tOpen, sw_tClose, (Place Wire), (Place Net Alias)

3) 시뮬레이션 조건

 

4) 전압 Probe 설정

V1
5V

R1

100k

C1
100u

U1

TOPEN = 50
1 2

U2
TCLOSE = 50

1

2

out

0

V

시정수     ×  sec
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5) Run PSpice

 Add Trace 명령을 실행하여 Trace Expression에 0.63212*5;Tau를 입력

 (범례 표시에는 Tau만 나타난다)

 Toggle Cursor 기능을 On 시킨다. Probe Cursor 창이 나타난다. 

 버튼을 눌러 search forward x value (10s)를 입력한다.

                                                       Mark Label을 클릭한다. 

           Time
0s 10s 20s 30s 40s 50s 60s 70s 80s 90s 100s

V(OUT) tau
0

2.0

4.0

6.0

(10.000,3.1579)
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과 제  - 트랜지스터를 이용한 비안정 발진기

R = 6.8㏀, 100㏀ 와 C = 0.01㎌, TR = 2N3904를 이용하여 비안정 발진회로를 구성하고 

시뮬레이션한 다음 발진주파수를 계산하시오.

해  설

커패시터의 충방전에 의하여 외부에서 펄스를 가하지 않아도 펄스를 발생하므로 비안정 회

로이다. 초기조건으로 C의 초기전압을 주어야 한다.

R1
6.8k

R2
100k

R3
100k

R4
6.8k

C1

0.01u
IC = 5V

C2

0.01u

Q1

Q2N3904

Q2

Q2N3904

out2out1 V1
6V

0

VV

   

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5
DC Sweep 해석

1. DC Sweep 해석

DC 해석에서는 모든 전원을 DC로 간주하고 모든 인덕터는 단락(Short)으로, 캐패시터는 개

방(Open)으로 간주하여 해석한다. 바이어스 포인트 계산, DC Sweep, 소신호 민감도 해석

(small signal sensitivity), 전달함수 계산(small signal transfer function) 등이 있다.

어떤 소자의 값을 변화시키는 과정을 Sweep이라 하는데 DC 전원, 온도, 전류원, 모델 파라

미터, Global 변수를 선택하여 선형적인 가변, Octave/Decade의 로그적인 가변과 가변시킬 

값의 리스트를 입력하여 해석할 수 있다.

2. Simulation Settings

- Primary Sweep : Sweep할 첫 번째 변수의 조건을 입력하여 DC Sweep 해석을 수행한다.

- Secondary Sweep : Sweep할 첫 번째 변수의 조건을 입력하여 DC Sweep 해석을 수행한

다. 이 때 Primary Sweep 변수가 일정한 가운데 Secondary sweep이 진

행되는 Nested 구조를 지닌다.

- Parametric Sweep : 글로벌 파라미터, 모델의 파라미터, 소자의 값 혹은 동작온도를 정해

진 순서에 따라 변화시키면서 특정한 기본 해석을 반복한다.

- Temperature(Sweep) : 동작온도를 정해진 순서에 따라 변화시켜 가면서 특정한 기본해석

을 반복한다.

- Save Bias Point : 현재 회로의 바이어스 포인트에 대한 데이터를 파일로 저장한다.
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- Load Bias Point : 이전에 계산하여 저장한 바이어스 포인터에 대한 데이터 파일을 Load 

한다.

- Sweep variable : Sweep할 변수에 대한 관련 사항과 변수명을 입력한다. sweep 변수의 

종류로는 전압원, 전류원, 글로벌 파라미터, 모델 파라미터, 온도 등이 있으

며, 전압원/전류원일 때는 전원의 이름, Global 파라미터를 선택한 경우에는 

파라미터, Model 파라미터를 선택한 경우에는 모델 type, 모델, 파라미터가 

active 되어 이에 입력해야 하며, Temperature를 선택하면 모든 입력항목이 

disable 된다.

- Sweep Type : Sweep type에는 Linear와 Logarithmic이 있으며, 그 선택여하에 따라 입력 

항목이 다르다.

▶ Linear를 선택한 경우

Start value : 시작 값을 입력한다.

End value : 끝 값을 입력한다.

Increment : 가감분을 입력한다.

▶ Logarithmic을 선택한 경우

Start value : 시작 값을 입력한다.

End value : 끝 값을 입력한다.

Points/Decade : Decade/Octave 당 데이터 수를 입력한다.

Value List를 선택한 경우에는 해당 입력란에 해석하기를 원하는 변수 값을 직접 입력한다. 

이 때 값의 분리는 space bar를 이용한다.
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따라하기

1) 회로도(제너 전압 레귤레이터)

V1
0Vdc

R1

10

R2
1k

D1
D1N750

in out

0
2) 사용기능 및 부품

(Place Part)VDC, R, D1N750, (Place Ground)GND

(Place Wire),   (Place Net Alias)

3) 시뮬레이션 조건

 

4) Probe 설정

V1
0Vdc

R1

10

R2
1k

D1
D1N750

in out

0

VV

전압안정기로 동작하는 제너다이오드의 항복 전압 특성을 확인할 수 있다.
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5) Run PSpice

4.8V 이상부터 약 5V의 일정 출력 전압이 출력 단에 나타난다.
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과 제  - 전압 레귤레이터

V1
0Vdc

R1
10 R2

1k
D1
D1N750

Q1
Q2N3904 outin

0
다음의 회로에서 입력전압이 8V일 때

의 제너 전류, 베이스 전류, 부하 R2에 흐르는 전류, 출력 전압, 저항 R1에 흐르는 전류를 

구하시오.

해  설

V1
0Vdc

R1
10 R2

1k
D1
D1N750

Q1
Q2N3904 outin

0

V

I
I

I

I

V
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6
AC Sweep/Noise 해석

1. AC Sweep 해석

AC 해석은 입력주파수를 변화시켜 가면서 회로시스템에 대한 주파수 응답을 계산하는 해석

이다. 주파수 응답을 계산하기 전에 각 소자의 small signal 파라미터를 결정하고 교류해석

에 대한 바이어스 포인트를 계산한다. 교류해석에서 시스템의 보드선도, 임피던스 해석이 있

다.

2. Noise 해석

회로 내에 사용하는 저항과 반도체 소자는 주파수에 영향을 받는 노이즈를 발생시키는데 이

러한 발생노이즈에 대해 해석하려면 교류해석과 병행해야 한다. 즉 교류해석의 각 주파수에 

대하여 회로내의 각 소자에서 발생하는 노이즈 량을 계산하고 출력 노드에 미치는 영향을 

분석하며 입력전원과 출력전압 사이의 이득을 계산하고, 이 계산을 토대로 특정전원에서의 

등가 입력 노이즈 량을 계산한다. 노이즈 발생원이 아닌  로 환산한 등가 노이즈원

이라는 사실이다. 즉 등가 노이즈 원을 이용하여 노이즈를 입력하여 출력되는 노이즈 량을 

해석한다.

3. Simulation Settings

- General Settings : 입력신호의 주파수 법위, 데이터 개수, 노이즈 해석을 위한 입출력 변

수 등을 입력하여 기본적인 AC/Noise 해석을 수행한다.

- Monte Carlo/Worst-Case : 어떤 영역 안에서 모든 소자의 모델 파라미터를 임의로 랜덤
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하게 변화시켜 가면서 그 변화에 따른 회로의 응답을 계산한다. 소자

의 오차 범위를 사용자가 설정할 수 있으며, Monte-Carlo 해석을 위해

서는 BREAKOUT의 라이브러리에 있는 소자를 사용하거나 SPECIAL 라

이브러리에 있는 VARIABLES를 사용하여야 한다.

- Parameter Sweep : 글로벌 파라미터, 모델 파라미터, 소자의 값 혹은 동작온도를 정해진 

순서에 따라 변화시켜 가면서 특정한 기본해석을 반복한다.

- Temperature(Sweep) : 동작온도를 정해진 순서에 따라 변화시켜 가면서 특정한 기본해석

을 반복한다.

- AC Sweep Type : 입력 교류신호의 주파수 sweep을 선형 혹은 지수 형태로 할 것인가를 

선택한다.

▶ Start Frequency : 시작 주파수를 입력한다.

▶ End : 끝점 주파수를 입력한다.

▶ Points/Decade : Total 데이터 수 혹은 Decade, Octave당의 데이터를 입력한다.

- Noise Analysis : Noise 해석의 Enable 여부를 선택한다.

▶ Output Voltage : Noise 출력 전압 노드를 입력한다.(Net Alias를 이용하여 

node에 이름을 부여하고 그 이름을 넣는다.)

▶ I/O Source : Source 명을 입력한다.

▶ Interval : 간격
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따라하기

1) 회로도(1극 저역통과 필터)

V1
1Vac
0Vdc

R1

33k

R2
5.6k

R3
10k

U1

uA741

+
3

-
2

V+
7

V-
4

OUT
6

OS1
1

OS2
5

C1
1n

out

0

0

0

V2
15V

V3
-15V

0

VCC VEE

VCC

VEE

2) 사용기능 및 부품

(Place Part)VAC, R, C, uA741, VDC, (Place Ground)VCC, GND

(Place Wire), (No connect), (Place Net Alias)

3) 시뮬레이션 조건

 

4) Probe 설정
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V1
1Vac
0Vdc

R1

33k

R2
5.6k

R3
10k

U1

uA741

+
3

-
2

V+
7

V-
4

OUT
6

OS1
1

OS2
5

C1
1n

out

0

0

0

V2
15V

V3
-15V

0

VCC VEE

VCC

VEE

VDB

5) Run PSpice

  

차단주파수를 찾기 위해

Toggle Cursor 버튼을 클릭하고

Search Command 버튼을 누른 다음

입력창에

search forward level (max-3)

을 입력하고 Mark Label 버튼을

클릭하여 데이터를 표시한다.

Measurement의 기능으로 차단주파수를 구해보려면

 Tools > Options를 클릭한 다음  체크한다.
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그런 다음  View > Measurement Results를 클릭하고

①

②

③

④

위 그림처럼 순서대로 마우스 클릭하여 Trace Expression에 Cutoff_Lowpass_3dB(V(out))이 

나타나게 한 다음 OK 버튼을 클릭하면 아래 그림과 같이 나타난다.

차단주파수  


×××


  
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과 제  - 인덕터 값에 따른 임피던스 및 컨덕턴스의 변화

V1
1Vac
0Vdc

R1
50

L1
5m

C1
1u

0

R2
50

L2
10m

C2
1u

R3
50

L3
15m

C3
1u

R4
50

L4
20m

C4
1u

V2
0Vdc

V3
0Vdc

V4
0Vdc

V5
0Vdc

출력단 전압이득 시뮬레이션

해  설

  

V1
1Vac
0Vdc

R1
50

L1
5m

C1
1u

0

R2
50

L2
10m

C2
1u

R3
50

L3
15m

C3
1u

R4
50

L4
20m

C4
1u

V2
0Vdc

V3
0Vdc

V4
0Vdc

V5
0Vdc

II II



6장 AC Sweep/Noise 해석

나인플러스 EDA (주)                                   44

- 컨덕턴스

           Frequency
1.0Hz 10Hz 100Hz 1.0KHz 10KHz 100KHz 1.0MHz

I(V2) I(V3) I(V4) I(V5)
0A

5mA

10mA

15mA

20mA

- 임피던스

Plot에서 Add Plot to Window → Trace에서 Add Trace 또는 Insert

1/I(V2), 1/I(V3), 1/I(V4), 1/I(V5)를 각각 입력
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임피던스 및 컨덕턴스 출력 결과

           Frequency
1.0Hz 10Hz 100Hz 1.0KHz 10KHz 100KHz 1.0MHz

I(V2) I(V3) I(V4) I(V5)
0A

10mA

20mA

SEL>>

1/I(V3) 1/I(V4) 1/I(V5) 1/ I(V2)
0

100K

200K

1/ I(V2)

임피던스

컨덕턴스
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7
Parametric 해석

1. Parametric 해석

Parametric 해석은 회로내의 소자 값을 변경하면서 회로특성이 어떻게 변화하는가를 살펴보

는 해석이다.

2. Goal Function (or Performance Analysis)

Parametric 해석을 실행한 후 특성평가의 편의를 위해 PSpice에서 제공하는 평가함수를 말

한다.

3. Measurement Definitions

Definition Finds the . . . 

Bandwidth Bandwidth of a waveform (you choose dB level) 

Bandwidth_Bandpass_3dB Bandwidth (3dB level) of a waveform 

Bandwidth_Bandpass_3dB_XRange 
Bandwidth (3dB level) of a waveform over a specified 
X-range 

CenterFrequency Center frequency (dB level) of a waveform 

CenterFrequency_XRange 
Center frequency (dB level) of a waveform over a specified 
X-range 

ConversionGain 
Ratio of the maximum value of the first waveform to the 
maximum value of the second waveform 

ConversionGain_XRange 
Ratio of the maximum value of the first waveform to the 
maximum value of the second waveform over a specified 
X-range 

Cutoff_Highpass_3dB High pass bandwidth (for the given dB level) 

Cutoff_Highpass_3dB_XRange High pass bandwidth (for the given dB level) 

Cutoff_Lowpass_3dB Low pass bandwidth (for the given dB level) 

Cutoff_Lowpass_3dB_XRange 
Low pass bandwidth (for the given dB level) over a 
specified range 

DutyCycle Duty cycle of the first pulse/period

DutyCycle_XRange Duty cycle of the first pulse/period over a range

Falltime_NoOvershoot Falltime with no overshoot.

Falltime_StepResponse Falltime of a negative-going step response curve

Falltime_StepResponse_XRange
Falltime of a negative-going step response curve
over a specified range
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Definition Finds the ...

GainMargin Gain (dB level) at the first 180-degree out-of-phase mark 

Max Maximum value of the waveform 

Max_XRange Maximum value of the waveform within the specified range of X 

Min Minimum value of the waveform 

Min_XRange Minimum value of the waveform within the specified range of X 

NthPeak Value of a waveform at its nth peak 

Overshoot Overshoot of a step response curve 

Overshoot_XRange Overshoot of a step response curve over a specified range 

Peak Value of a waveform at its nth peak 

Period Period of a time domain signal 

Period_XRange Period of a time domain signal over a specified range 

PhaseMargin Phase margin 

PowerDissipation_mW 
Total power dissipation in milli-watts during the final period of 
time (can be used to calculate total power dissipation, if the 
first waveform is the integral of V(load) 

Pulsewidth Width of the first pulse 

Pulsewidth_XRange Width of the first pulse at a specified range 

Q_Bandpass 
Calculates Q (center frequency / bandwidth) of a bandpass 
response at the specified dB point 

Q_Bandpass_XRange 
Calculates Q (center frequency / bandwidth) of a bandpass 
response at the specified dB point and the specified range 

Risetime_NoOvershoot Risetime of a step response curve with no overshoot 

Risetime_StepResponse Risetime of a step response curve 

R is e t im e _ S te p R e sp o n se _X R a n g e  Risetime of a step response curve at a specified range 

SettlingTime 
Time from <begin_x> to the time it takes a step response to 
settle within a specified band 

SettlingTime_XRange 
Time from <begin_x> to the time it takes a step response to 
settle within a specified band and within a specified range 

SlewRate_Fall Slew rate of a negative-going step response curve 

SlewRate_Fall_XRange 
Slew rate of a negative-going step response curve over an 
X-range 

SlewRate_Rise Slew rate of a positive-going step response curve 

SlewRate_Rise_XRange 
Slew rate of a positive-going step response curve over an 
X-range 

Swing_XRange 
Difference between the maximum and minimum values of the 
waveform within the specified range 

XatNthY 
Value of X corresponding to the nth occurrence of the given 
Y_value, for the specified waveform 

XatNthY_NegativeSlope 
Value of X corresponding to the nth negative slope crossing of 
the given Y_value, for the specified waveform 

XatNthY_PercentYRange 
Value of X corresponding to the nth occurrence of the 
waveform crossing the given percentage of its full Y-axis range; 
specifically, nth occurrence of Y=Ymin+(Ymax-Ymin)*Y_pct/100 

XatNthY_Positive Slope 
Value of X corresponding to the nth positive slope crossing of 
the given Y_value, for the specified waveform 
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Definition Find the ... 

YatFirstX Value of the waveform at the beginning of the X_value range 

YatLastX Value of the waveform at the end of the X_value range 

YatX Value of the waveform at the given X_value 

YatX_PercentXRange Value of the waveform at the given percentage of the X-axis range 

ZeroCross X-value where the Y-value first crosses zero 

ZeroCross_XRange X-value where the Y-value first crosses zero at the specified range 

4. 소자 사용 방법

    

R1

{Rvar}

파라미터 해석을 하기 위해서는 소자 값을 {변수명} 형식으로 입력하고 Place Part에서 

param 소자를 불러온다. 그런 다음 parameters를 더블 클릭하여 변수명 등록을 한다.

OK 버튼은 변수 추가 후 종료 시, Apply 버튼은 변수 계속 추가 시 사용한다.
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Rvar 변수 명을 클릭하고 Display 버튼을 클릭한 다음 Name and Value 항목을 선택하고 

OK 버튼을 클릭하면 PARAMETERS 항목에 Rvar=10k 라는 속성이 Display 된다.
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따라하기

1) 회로도

U1A

LM2902/NS

+
3

-
2

V+
4

V-
11

OUT
1

V1

FREQ = 1k
VAMPL = 1
VOFF = 0

R1

10k

R2

{Rvar}

V2
15Vdc

V3
-15Vdc

VCCVEE VEE

VCC

0 0

0

out

in

PARAMETERS:
Rvar = 10k

2) 사용기능 및 부품

(Place Part)VSIN, R, LM2902/NS, VDC, PARAM (Place Ground)VCC, GND

(Place Wire), (Place Net Alias)

3) 시뮬레이션 조건
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4) Probe 설정

U1A

LM2902/NS

+
3

-
2

V+
4

V-
11

OUT
1

V1

FREQ = 1k
VAMPL = 1
VOFF = 0

R1

10k

R2

{Rvar}

V2
15Vdc

V3
-15Vdc

VCCVEE VEE

VCC

0 0

0

out

in

PARAMETERS:
Rvar = 10k

V

V

5) Run PSpice

           Time
0s 0.5ms 1.0ms 1.5ms 2.0ms 2.5ms 3.0ms

V(IN) V(OUT)
-4.0V

-2.0V

0V

2.0V

4.0V

이득   








 


 


 


 


 
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과 제  - 반파 정류 회로의 필터

1㎑ 30V의 Sine파와 D1N914, R = 1㏀, C = 1㎌, 2㎌, 5㎌을 이용하여 반파 정류회로를 구

성하고 3ms까지 시뮬레이션 하시오.

해  설

V1

FREQ = 1KHz
VAMPL = 30V
VOFF = 0

D1

D1N914

R1
1k C1

{Cvar}

out

0

PARAMETERS:
Cvar = 1uF

V
V
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8
전압원/전류원 활용

1. 아날로그 전압원(V) 및 전류원(I)의 종류

심볼명 부품모양 속  성 의   미 용   도

VDC
(IDC)

V1
5Vdc VDC= 직류전류 값

직류전압 전원용
DC Sweep용

VAC
(IAC)

V2
1Vac
0Vdc

DC=
ACPULSE=
ACMAG=

교류에 타고 있는 직류 값
교류위상
교류진폭

주파수해석용
(AC Sweep용)

VSIN
(ISIN)

V3

FREQ =
VAMPL =
VOFF =

DC=
AC=

교류에 타고 있는 직류 값
교류진폭

주파수해석용
(AC Sweep용)

VOFF=
VAMPL=
FREQ=
DF=
PHASE=

교류에 타고 있는 직류 값
교류진폭
주파수
Damping Factor
위상

과도해석용
(Transient 해석용)

VPULSE
(IPULSE)

V4

TD =

TF =
PW =
PER =

V1 =

TR =

V2 =

DC=
AC=

교류에 타고 있는 직류 값
교류진폭

주파수해석용
(AC Sweep용)

V1=
V2=
TD=
TR=
TF=
PW=
PER=

최초 Stage값
두 번째 Stage값
신호 지연시간
신호 상승시간
신호 하강시간
펄스폭
주기(Period=T)

과도해석용
(Transient 해석용)

전류의 경우 전압과의 심볼명이 V가 아닌 I로 바뀌고 기능이나 의미, 용도는 동일하게 사
용된다. 다음은 전압에서 나열한 것과 마찬가지로 전류원에 대해 나타내었다.

(가) IDC        (나) IAC        (다) ISIN       (라) IPULSE

I1
0Adc

   

I2

0Adc
1Aac

   

I3
IOFF =

FREQ =
IAMPL =

   

I4

TD =

TF =
PW =
PER =

I1 =
I2 =

TR =

기타 : VEXP(IEXP), VSFFM(ISFFM), VPWL(IPWL), VSRC(ISRC), VPWL_FILE(IPWL_FILE), ... etc.
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2. 디지털 전압원

심볼명 부품모양 속  성 의   미 용   도

Stim1 S1
DSTM1 COMMAND1

...
COMMANDN

디지털 1 Signal 입력원 디지털 입력용

Stim4

Stim8

Stim16

S4
DSTM2

S8
DSTM3

S16
DSTM4

COMMAND1
...

COMMANDN

디지털 4 bit 입력원

디지털 8 bit 입력원

디지털 16 bit 입력원

디지털 입력용

FileStim1
F1

DSTM5

SIGNAME =
FILENAME =

COMMAND1
...

COMMANDN
디지털 1 Signal 입력원

파일을 이용한
디지털 입력용

FileStim2

FileStim4

FileStim8

FILESTIM16

FileStim32

F2
DSTM6

SIGNAME =
FILENAME =

F4
DSTM7

SIGNAME =
FILENAME =

F8
DSTM8

SIGNAME =
FILENAME =

F16
DSTM9

SIGNAME =
FILENAME =

F32
DSTM10

SIGNAME =
FILENAME =

FILENAME :
절대/상대 경로 

파일명

SIGNAME :
신호명

디지털 2 bit 입력원

디지털 4 bit 입력원

디지털 8 bit 입력원

디지털 16 bit 입력원

디지털 32 bit 입력원

파일을 이용한
디지털 입력용
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심볼명 부품모양 속  성 의   미 용   도

DigStim1 S1
DSTM11

Implementation =

Implementation :
신호원 명칭

디지털 1 Signal
클럭 입력원

Stimulus를
이용한
디지털 입력용

DigStim2

DigStim4

DigStim8

DigStim16

DigStim32

S2
DSTM12

Implementation =

S4
DSTM13

Implementation =

S8
DSTM14

Implementation =

S16
DSTM15

Implementation =

S32
DSTM16

Implementation =

Implementation :
신호원 명칭

디지털 2 bit
클럭입력원

디지털 4 bit
클럭 입력원

디지털 8 bit
클럭 입력원

디지털 16 bit
클럭 입력원

디지털 32 bit
클럭 입력원

Stimulus를
이용한
디지털 입력용

3. 디지털 클럭 전압원

4. 디지털 신호원 사용 예

1) Stim(N)

S1
DSTM1

COMMAND1 = 0s 1 

S4
DSTM2

COMMAND1 = 0s 0101 

S8
DSTM3

COMMAND1 = 0s 00110000 

S16
DSTM4

COMMAND1 = 0s 0123

2) FileStim(N)(신호명과 값 사이에 반드시 한줄 띄워 쓰기)

F1
DSTM5

SIGNAME = CLK
FILENAME = C:\SRC.STM

      

F16
DSTM9

SIGNAME = CLK
FILENAME = SRC.STM

절대경로                                  상대경로(프로젝트의 프로파일명폴더내)
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3) DigStim(N)

   

  

5. 기타 사용 예

1) VPWL_RE_FOREVER(IPWL_RE_FOREVER) : 삼각파 만들기

V1

FIRST_NPAIRS = 0,3
SECOND_NPAIRS = 5m,-3
THIRD_NPAIRS = 10m,3

R1
1k

out

0

V
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2) VPWL_RE_N_TIMES(IPWL_RE_N_TIMES)

                     : Rectangular Pulse {0 for 0<t<0.25ms, 2V for 0.26<t<0.99ms}

V2

FIRST_NPAIRS = (0.25,0)(0.26,2)(0.99,2)(1,0)

TSF = 1m
VSF = 1
REPEAT_VALUE = 10

R2
1k

out

0

V

3) VPWL_ENH(IPWL_ENH) : Triangle Wave, TSF, VSF(ISF)

V3

TSF = 1ms
VSF = 1V
FIRST_NPAIRS = 0,0, 0.5,-1, 1,0, 1.5,1, 2,0, 2.5,-1, 3,0, 3.5,1, 4,0

R3
1k

out

0

V
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따라하기

1) 회로도

V1

FREQ = 60Hz
VAMPL = 10V
VOFF = 0

CLK
DSTM1

OFFTIME = 7ms
ONTIME = 1ms
DELAY = 5ms
STARTVAL = 0
OPPVAL = 1

R1

10

X1
2N5444

R2
10

in

out

gate

0
2) 사용기능 및 부품

(Place Part)VSIN, DigClock(Source.olb), R, 2N5444, (Place Ground)GND

(Place Wire), (Place Net Alias)

3) 시뮬레이션 조건

 

4) Probe 설정

V1

FREQ = 60Hz
VAMPL = 10V
VOFF = 0

CLK
DSTM1

OFFTIME = 7ms
ONTIME = 1ms
DELAY = 5ms
STARTVAL = 0
OPPVAL = 1

R1

10

X1
2N5444

R2
10

in

out

gate

0

V+

V

V

V-
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5) Run PSpice

TRIAC은 SCR에서 파생된 양방향 전류를 제어하기 위한 전력용 반도체 소자이며 2개의 SCR 

회로로 같은 기능을 구현할 수 있다. TRIAC은 양방향 위상제어 특성을 가지고 있으므로 일

정한 교류전압을 가변교류전압으로 변환할 때 주로 이용한다.

Add Plot 명령을 이용하여 각각의 Plot Window에 Trace를 배치할 수 있다.
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과 제  고조파 합성

9V 1㎑, 3V 3㎑, 1V 5㎑ 신호를 합성하여 시뮬레이션 하시오.

해  설

V1

FREQ = 1k
VAMPL = 9v
VOFF = 0v

R1

1

V2

FREQ = 3k
VAMPL = 3v
VOFF = 0v

R2
1

V3

FREQ = 5k
VAMPL = 1v
VOFF = 0v

R3
1

0 0 0

RL
1k

0

out

V VVV
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9
Model Editor 활용

1. Model Editor 화면구성

2. Toolbar

 ① ②  ③  ④ ⑤  ⑥  ⑦ ⑧ ⑨                
① New Library : 라이브러리 생성

② Open Library : 라이브러리 열기

③ Save Library : 라이브러리 저장

④ Print Model Directly : 모델 데이터 출력

⑤ Print Preview : 출력 미리보기

⑥ Encrypt Library : 라이브러리 암호화

⑦ Cut : 잘라내기
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⑧ Copy : 복사하기

⑨ Paste : 붙여넣기

 Zoom In : 화면 확대

 Zoom Out : 화면 축소

 Zoom Area : 영역 확대

 Zoom to Fit Data : 데이터 영역에 자동 맞춤

 New Model : 새 모델 생성

 Toggle X : X축 Log 또는 Linear Scaling 선택

 Toggle Y : Y축 Log 또는 Linear Scaling 선택

 Extract : 모델 파라미터 추출

 Sync Splitters : 모델 데이터 윈도우의 동기화

 Update Graph : 그래프 업데이트

 Auto Refresh : 데이터 변화 후 자동 갱신

3. Model Device Characters

Diode .MODEL D 

Bipolar transistor .MODEL Q 

Bipolar transistor, Darlington model .SUBCKT X 

IGBT .MODEL Z 

JFET .MODEL J 

MOSFET .MODEL M

Operational Amplifier .SUBCKT X

Voltage Comparator .SUBCKT X

Voltage Regulator .SUBCKT X

Voltage Reference .SUBCKT X

Magnetic Core .MODEL K

4. PSpice Template

R^@REFDES %1 %2 ?TOLERANCE|R^@REFDES| @VALUE  ?TOLERANCE| \n.model 

R^@REFDES RES R=1 DEV=@TOLERANCE%|

- R^@REFDES 는 저항의 Reference syntax

- %1 %2는 저항의 핀 번호 정의

- ? ~ 는 저항의 Device Tolerance를 정의하기 위한 P S p ic e  syntax

* Tolerance를 정의하지 않는다면 간단히 아래와 같이 표현할 수 있다.

R&@refdes %1 %2 @value 

➜ Translate  :   R_R1 0 vcc 5k 의 Netlist로 변환.

   여기서, 0 vcc는 %1 %2에 정의된 저항 양단의 노드 표현.
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5. Model Parameters

1) Capacitor Model Parameters

Model parameters Description Unit Default

C capacitance multiplier 1.0

TC1 linear temperature coefficient °C 0.0

TC2 quadratic temperature coefficient °C 0.0

T_ABS absolute temperature °C

T_MEASURED measured temperature °C

T_REL_GLOBAL relative to current temperature °C

T_REL_LOCAL relative to AKO model temperature °C

VC1 linear voltage coefficient volt 0.0

VC2 quadratic voltage coefficient volt 0.0

C Value  value⋅C⋅VC⋅VVC⋅V ⋅TC⋅TTnom TC⋅TTnom 

2) Diode Model Parameters

Model parameters Description Unit Default

AF flicker noise exponent 1.0
BV reverse breakdown knee voltage volt infinite
CJO zero-bias p-n capacitance farad 0.0
EG bandgap voltage(barrier height) eV 1.11
FC forward-bias depletion capacitance coefficient 0.5
IBVL low-level reverse breakdown knee current amp 0.0
IBV reverse breakdown knee current amp 1E-10
IKF high-injection knee current amp infinite
IS saturation current amp 1E-14
ISR recombination current parameter amp 0.0
KF flicker noise coefficient 0.0
M p-n grading coefficient 0.5
N emission coefficient 1.0
NBV reverse breakdown ideality factor 1.0
NBVL low-level reverse breakdown ideality factor 1.0
NR emission coefficient for isr 2.0
RS parasitic resistance ohm 0.0
TBV1 bv temperature coefficient(linear) °C 0.0
TBV2 bv temperature coefficient(quadratic) °C 0.0
TIKF ikf temperature coefficient(linear) °C 0.0
TRS1 rs temperature coefficient(linear) °C 0.0
TRS2 rs temperature coefficient(quadratic) °C 0.0
TT transit time sec 0.0
T_ABS absolute temperature °C
T_MEASURED measured temperature °C
T_REL_GLOBAL relative to current temperature °C
T_REL_LOCAL Relative to AKO model temperature °C
VJ p-n potential volt 1.0
XTI IS temperature exponent 3.0
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<model name> Model name은 일반적인 Part명, Implementation Name과 같은 개념.
<reference model name>
AKO는 (A Kind Of)의 약자로 다른 모델타입의 특성파라미터와 비슷한 모델을 정의할 때 사용된다.
예) .model D1N4003 ako:D1N4001 D(Bv=300) ; use non-rep. peak voltage
   > D1N4003은 D1N4001과 같은 특성의 Device이며 Breakdown Voltage만 300V임을 나타낸다.

3) Inductor Coupling(and Magnetic Core)

Jiles Atherton Model

Model parameters Description Unit Default

A Thermal energy parameter amp/meter 1E+3 

AREA Mean magnetic cross-section cm2 0.1 

C Domain flexing parameter 0.2 

GAP Effective air-gap length cm 0 

K Domain anisotropy parameter amp/meter 500 

LEVEL Model index 2 

MS Magnetization saturation amp/meter 1E+6 

PACK Pack2 (stacking) factor 1.0 

PATH Mean magnetic path length cm 1.0 

4) Inductor Model Parameters

Model parameters Description Unit Default

L Inductance multiplier 1.0

IL1 Linear current coefficient amp 0.0

IL2 Quadratic current coefficient amp 0.0

TC1 Linear temperature coefficient °C 0.0

TC2 Quadratic temperature coefficient °C 0.0

T_ABS Absolute temperature °C

T_MEASURED Measured temperature °C

T_REL_GLOBAL Relative to current temperature °C

T_REL_LOCAL Relative to AKO model temperature °C

L Value  value⋅L⋅ IL⋅I IL⋅I ⋅TC⋅TTnom TC⋅TTnom 

5) MOSFET Model Parameters

LEVEL=1 Shichman-Hodges model
LEVEL=2 geometry-based, analytic model
LEVEL=3 semi-empirical, short-channel model
LEVEL=4 BSIM1 model
LEVEL=5 EKV model version 2.6
LEVEL=6 BSIM3 model version 2.0
LEVEL=7 BSIM3 model version 3.2
LEVEL=8 BSIM4 model version 4.1.0
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Model parameters Description Unit Default

AF flicker noise exponent 1 

CBD zero-bias bulk-drain p-n capacitance farad 0 

CBS zero-bias bulk-source p-n capacitance farad 0 

CGBO gate-bulk overlap capacitance/channel length farad/meter 0 

CGDO gate-drain overlap capacitance/channel width farad/meter 0 

CGSO gate-source overlap capacitance/channel width farad/meter 0 

CJ bulk p-n zero-bias bottom capacitance/area farad/meter2 0 

CJSW bulk p-n zero-bias sidewall capacitance/length  farad/meter 0 

FC bulk p-n forward-bias capacitance coefficient 0.5 

GDSNOI channel shot noise coefficient (use with NLEV=3) 1 

IS bulk p-n saturation current amp 1E-14 

JS bulk p-n saturation current/area amp/meter2 0 

JSSW bulk p-n saturation sidewall current/length amp/meter 0 

KF flicker noise coefficient 0 

L channel length meter DEFL 

LEVEL model index 1 

MJ bulk p-n bottom grading coefficient 0.5 

MJSW bulk p-n sidewall grading coefficient 0.33 

N bulk p-n emission coefficient 1 

NLEV noise equation selector 2 

PB bulk p-n bottom potential volt 0.8 

PBSW bulk p-n sidewall potential volt PB 

RB bulk ohmic resistance ohm 0 

RD drain ohmic resistance ohm 0 

RDS drain-source shunt resistance ohm infinite 

RG gate ohmic resistance ohm 0 

RS source ohmic resistance ohm 0 

RSH drain, source diffusion sheet resistance ohm/square 0 

TT bulk p-n transit time sec 0 

T_ABS absolute temperature °C

T_MEASURED measured temperature °C

T_REL_GLOBAL relative to current temperature °C

T_REL_LOCAL relative to AKO model temperature °C

W channel width meter DEFW 

Levels 1,2,3

Parameters Description Unit Default 

DELTA width effect on threshold 0

ETA static feedback (Level 3) 0

GAMMA bulk threshold parameter volt1/2 

KP transconductance coefficient amp/volt2 2.0E-5

KAPPA saturation field factor (Level 3) 0.2

LAMBDA channel-length modulation (Levels 1 and 2) volt 0.0
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LD lateral diffusion (length) meter 0.0

NEFF channel charge coefficient (Level 2) 1.0

NFS fast surface state density 1/cm2 0.0

NSS surface state density 1/cm2 none

NSUB substrate doping density 1/cm3 none

PHI surface potential volt 0.6

THETA mobility modulation (Level 3) volt 0.0

TOX oxide thickness meter 

TPG

Gate material type: 
+1 = opposite of substrate 
-1 = same as substrate 
0 = aluminum 

+1

UCRIT mobility degradation critical field (Level 2) volt/cm 1.0E4

UEXP mobility degradation exponent (Level 2) 0.0

UTRA (not used)mobility degradation transverse field coefficient 0.0

UO surface mobility cm2/volt·sec 600

VMAX maximum drift velocity meter/sec 0

VTO zero-bias threshold voltage volt 0

WD lateral diffusion (width) meter 0

XJ metallurgical junction depth (Levels 2 and 3) meter 0

XQC fraction of channel charge attributed to drain  1.0

6) BJT Model Parameters

Parameters Description Unit Default 

AF flicker noise exponent 1.0 

BF ideal maximum forward beta 100.0 

BR ideal maximum reverse beta 1.0 

CJC base-collector zero-bias p-n capacitance farad 0.0 

CJE base-emitter zero-bias p-n capacitance farad 0.0 

CJS (CCS) substrate zero-bias p-n capacitance farad 0.0 

CN quasi-saturation temperature coefficient for hole mobility 

2.42 
NPN 
2.20 
PNP 

D 
quasi-saturation temperature coefficient for 
scattering-limited hole carrier velocity 

0.87 
NPN 
0.52 
PNP 

EG bandgap voltage (barrier height) eV 1.11 

FC forward-bias depletion capacitor coefficient 0.5 

GAMMA epitaxial region doping factor 1E-11 

IKF (IK) corner for forward-beta high-current roll-off amp infinite 

IKR corner for reverse-beta high-current roll-off amp infinite 

IRB current at which Rb falls halfway to amp infinite 

IS transport saturation current amp 1E-16 
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ISC (C4) base-collector leakage saturation current amp 0.0 

ISE (C2) base-emitter leakage saturation current amp 0.0 

ISS substrate p-n saturation current amp 0.0 

ITF transit time dependency on Ic amp 0.0 

KF flicker noise coefficient 0.0 

MJC (MC) base-collector p-n grading factor 0.33 

MJE (ME) base-emitter p-n grading factor 0.33 

MJS (MS) substrate p-n grading factor 0.0 

NC base-collector leakage emission coefficient 2.0 

NE base-emitter leakage emission coefficient 1.5 

NF forward current emission coefficient 1.0 

NK high-current roll-off coefficient 0.5 

NR reverse current emission coefficient 1.0 

NS substrate p-n emission coefficient 1.0 

PTF excess phase @ 1/(2π·TF)Hz degree 0.0 

QCO epitaxial region charge factor coulomb 0.0 

QUASIMOD

quasi-saturation model flag for temperature dependence 
if QUASIMOD = 0, then no GAMMA, RCO, VO 
temperature dependence 
if QUASIMOD = 1, then include GAMMA, RCO, VO 
temperature dependence 

0 

RB zero-bias (maximum) base resistance ohm 0.0 

RBM minimum base resistance ohm RB 

RC collector ohmic resistance ohm 0.0 

RCO epitaxial region resistance ohm 0.0 

RE emitter ohmic resistance ohm 0.0 

TF ideal forward transit time sec 0.0 

TR ideal reverse transit time sec 0.0 

TRB1 RB temperature coefficient (linear) °C 0.0 

TRB2 RB temperature coefficient (quadratic) °C 0.0 

TRC1 RC temperature coefficient (linear) °C 0.0 

TRC2 RC temperature coefficient (quadratic) °C 0.0 

TRE1 RE temperature coefficient (linear) °C 0.0 

TRE2 RE temperature coefficient (quadratic) °C 0.0 

TRM1 RBM temperature coefficient (linear) °C 0.0 

TRM2 RBM temperature coefficient (quadratic) °C 0.0 

T_ABS absolute temperature °C 

T_MEASURED measured temperature °C 

T_REL_GLOBAL relative to current temperature °C 

T_REL_LOCAL relative to AKO model temperature °C 

VAF (VA) forward Early voltage volt infinite 

VAR (VB) reverse Early voltage volt infinite 

VG quasi-saturation extrapolated bandgap voltage at 0° K V 1.206 

VJC (PC) base-collector built-in potential volt 0.75 
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VJE (PE) base-emitter built-in potential volt 0.75 

VJS (PS) substrate p-n built-in potential volt 0.75 

VO carrier mobility knee voltage volt 10.0 

VTF transit time dependency on Vbc volt infinite 

XCJC fraction of CJC connected internally to Rb 1.0 

XCJC2 fraction of CJC connected internally to Rb 1.0 

XCJS fraction of CJS connected internally to Rc 

XTB forward and reverse beta temperature coefficient 0.0 

XTF transit time bias dependence coefficient 0.0 

XTI (PT) IS temperature effect exponent 3.0 

7) Resistor Model Parameters

Parameters Description Unit Default 

R resistance multiplier 1.0 

TC1 linear temperature coefficient °C 0.0 

TC2 quadratic temperature coefficient °C 0.0 

TCE exponential temperature coefficient %/°C 0.0 

T_ABS absolute temperature °C

T_MEASURED measured temperature °C

T_REL_GLOBAL relative to current temperature °C

T_REL_LOCAL relative to AKO model temperature °C

R Value  value⋅R⋅TCE⋅TTnom

R Value  value⋅R⋅TC⋅TTnom TC⋅TTnom 

6. Subcircuit Template을 이용한 모델 생성

.SUBCKT 74LS00 A B Y
+ OPTIONAL: DPWR=$G_DPWR DGND=$G_DGND
+ PARAMS: MNTYMXDLY=0 IO_LEVEL=0
...
.ENDS

예)

U1

LF411

+
3

-
2

V+
7

V-
4

OUT
6

B1
1

B2
5
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Subcircuit 제작법은 여러 가지 방법이 있다. 결과적으로 ASCII의 format으로 이루어진 lib 

파일을 제작하는 것이 목적이며, 앞서 사용한 Model Editor에서는 Capture에서 사용되는 

Olb파일을 자체적으로 생성시켜 준다. Lib 파일을 만드는 방법에는 반도체 Vendor Web 

page에 Open된 라이브러리를 개인 pc로 불러 들이는 방법과 작업 중 Schematic을 lib 

format으로 제작하는 방법이 있다. 두번째 언급한 Schematic을 lib format으로 제작하는 

방법에는 Capture에서 지원되는 Create Netlist를 이용할 수 있으며, Hierarchy 형식 및 

Subcircuit형식을 이용 가능하다.

일반 .model 형식과 구분되는 것은 Capture에서 사용되는 심벌을 지원하지는 않으며, 

Subckt format이 위 그림과 같이 차이가 있다. Model Format을 이해하고, Capture에서 

netlist 생성시 필요한 Subckt 핀을 자체 생성해 주거나 편집할 수 있다.

먼저 회로 시뮬레이션이 필요하다.

프로젝트를 XFrm_ex로 생성해서 다음과 같은 회로를 그린다.

사용하는 부품은 VSIN, R, L, C, D1N4004, K1041T060_3E2A, GND이다.

D1

D1N4004

D2

D1N4004

D3

D1N4004

D4

D1N4004

D5

D1N4004

D6

D1N4004

D7

D1N4004

D8

D1N4004

C1
680u

C2
220u

R3
1k

R4
1k

0

V1

FREQ = 60
VAMPL = 230
VOFF = 0

AC_SEC1

AC_SEC2

DC_SEC1

DC_SEC2

Rs

0.01

Lpri
5200

1

2

Lsec1
356

1

2

Lsec2
271

1

2

Rvg

1G

AC_IN

K

COUPLING=

K1

0.85
K1041T060_3E2A

L1 = Lpri

L2 = Lsec1

L3 = Lsec2

V-

V+

V-

V+

V

V-

V+

V-

V+

시뮬레이션 프로파일명은 Tran_60ms로 생성한다.
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Plot > Add Plot to Window 명령을 실행하고 V(AC_IN)을 새로 생성된 Window로 옮긴다.

아래 그림처럼 모델로 사용할 부품만 복사하고 프로젝트를 종료한 다음 새로 xfrmmodel_ex

로 프로젝트를 생성하여 복사한 부분을 붙여 넣는다. 부품핀으로 사용할 부분은 Place Port

를 이용해서 완성한다.(포트방향은 구애받지 않으나 이왕이면 방향을 고려하여 붙인다.)

Rs

0.01

Lpri
5200

1

2

Lsec1
356

1

2

Lsec2
271

1

2
Rvg

1G

AC_IN

AC_SEC1

AC_SEC2

K

COUPLING=

K1

0.85
K1041T060_3E2A

L1 = Lpri

L2 = Lsec1

L3 = Lsec2

AC_IN

GND

AC_SEC1

AC_CT

AC_SEC2
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먼저 xfrmmodel_ex.dsn 부분을 클릭하고 Create Netlist 버튼을 클릭한다.

PSpice 탭에서 Create SubCircuit Format Netlist를 선택하고 C:\OrCAD_Data\MyXfrm.lib로 

입력하고 View Output를 체크한 다음 OK 버튼을 클릭하면 결과창이 나타난다.

Error창이 뜨지만 접지가 없다는 문구이므로 그냥 OK해도 된다.

  

변경 전

변경 후

모델명과 부품핀 순서를 필요에 따라 수정한다.

 닫기 버튼을 눌러 저장하고 빠져 나간다.
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위의 경로에서 Model Editor를 실행한다.

   

Export to Capture Part Library 메뉴를 실행하고 MyXfrm.lib 경로를 입력하면 MyXfrm.olb 

파일이 자동으로 생성된다.

프로젝트 매니저창을 클릭하고 File > Close Project를 클릭해서 저장하고 빠져 나간다.

 

 이전 작업했던 Xfrm_Ex.opj를 선택한다.
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 프로젝트 매니저의 Library 폴더를 클릭하고 마우스 오른쪽 

버튼을 눌러 Add File을 실행하고 C:\OrCAD_Data\MyXfrm.olb를 찾아 열기한다.

라이브러리가 추가되었고 MyXfrm을 클릭하면 모델 내부를 볼 수 있다.

모델 내부 핀 배정을 아래와 같이 한다. 빨간색 핀을 드래그하여 위치를 이동시킨다.
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 닫기 버튼을 눌러 저장하고 나간다. 

Place Part에서 MyXfrm을 불러와 회로를 수정한다.

D1

D1N4004

D2

D1N4004

D3

D1N4004

D4

D1N4004

D5

D1N4004

D6

D1N4004

D7

D1N4004

D8

D1N4004

C1
680u

C2
220u

R3
1k

R4
1k

0

V1

FREQ = 60
VAMPL = 230
VOFF = 0

AC_SEC1

AC_SEC2

DC_SEC1

DC_SEC2

AC_IN
U1

MYXFRM

AC_IN
1

GND
2

AC_SEC1
3

AC_CT
4

AC_SEC2
5

V+

V

V-

V+

V-

V+

V-

V+

V-

 Edit Simulation Settings 버튼을 클릭한다.
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Configuration Files 탭에서 Category에 Library를 클릭하고 위 Browse 버튼을 클릭하여 

C:\OrCAD_Data\MyXfrm.lib를 찾은 다음 Add to Design 버튼을 눌러 항목에 추가한 다음 

확인 버튼을 누른다.

만약 이렇게 하지 않을 경우 사용자가 만든 라이브러리를 추가했을 때 오류가 난다.

Run PSpice를 실행하면 이전 회로의 결과와 동일하게 나타난다.
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따라하기

1) 회로도

D1
D1N750

R1

1k

V1
0Vdc

out

0
2) 사용기능 및 부품

(Place Part)VDC, R, D1N750, (Place Ground)GND

(Place Wire), (Place Net Alias)

3) 시뮬레이션 조건

 

4) Probe 설정

D1
D1N750

R1

1k

V1
0Vdc

out

0

V
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5) Run PSpice

 Capture에서 D1N750 모델 클릭 후 마우스 오른쪽 버튼을 눌러 

Edit PSpice Model 메뉴를 선택한다.

Bv 값을 8로 수정하고 저장한 다음 빠져 나간다.
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다시 한번 더 Run PSpice를 실행시키면 8V 근처에서 Breakdown이 일어남을 볼 수 있다.

Edit Simulation Settings 에서 Secondary Sweep에서 설정 후 시뮬레이션 한다.

시뮬레이션을 실행하면 다음과 같다. 
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    Secondary Sweep 경우

    Parametric Sweep 경우
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과 제  - Clipper 회로 만들기

아래의 (1) 회로로 MY_Clip 모델을 만들고 (2) 회로로 시뮬레이션 하시오

(1)

   

D1
D1N3940

D2
D1N3940

R1

1k

R2
3.3k

R3
1k

V1
5V

COUT

0.47u

MID

R4
1k

VCC

VCC

0

0

OUTIN

MID

(2)

 

U1

MY_CLIP

IN
1 MID

2

OUT
3

V1
1Vac
0Vdc

R1
10G

R2
10G

0 0

VDB

VDB

해  설
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U1

MY_CLIP

IN
1 MID

2

OUT
3

V1
1Vac
0Vdc

R1
10G

R2
10G

00

  

           Frequency
1.0Hz 10Hz 100Hz 1.0KHz 10KHz 100KHz 1.0MHz 10MHz 100MHz

DB(V(R2:2)) DB(V(U1:MID))
-60

-40

-20

-0
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10
Monte-Carlo/Worst-Case 해석

1. Monte-Carlo 해석

몬테카를로 해석은 허용범위 안에 모든 소자의 파라미터 값을 랜덤하게 변화시키면서 회로

의 응답을 구하는 해석이다. 이 결과로부터 소자 파라미터 변동에 따른 특성변화에 대한 통

계적인 데이타를 구할 수 있고, 회로가 실제 현장에서 동작할 때 어떤 특성변화가 존재할 

것인가를 예측할 수 있다.

  

2. Worst-Case 해석

모든 구성 요소의 상태가 동시에 최악이 되었을 때에도 회로가 정상적으로 기능을 발휘할 

수 있도록 설계하여 신뢰도가 매우 높은 설계를 할 수 있도록 해석하여 사용한다.
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3. Tolerance

1) DEV

Device Tolerance로 독립적으로 변할 수 있는 한계를 의미한다.

2) LOT

회로내의 소자가 다음번 수행 시에 변화할 수 있는 허용한계를 의미한다.

예를 들어 R=1 DEV=2% LOT=10%와 같다면 매실행시마다 LOT=10%에 의해 저항이 10%

씩 같은 값으로 변동한 다음 DEV=2%에 의해 다시 각각 2%씩 변동할 수 있음을 의미한다. 

따라서 최대 12%까지의 변동이 허용된다.
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따라하기

1) 회로도

R1

Rmonte
1k

R2

Rbreak
1k

0

V1
10V

out

2) 사용기능 및 부품

(Place Part)VDC, Rbreak, (Place Ground)GND, (Place Wire), (Place Net Alias)

3) 시뮬레이션 조건

 

4) Probe 설정

R1

Rmonte
1k

R2

Rbreak
1k

0

V1
10V

out

V



10장 Monte-Carlo/Worst-Case 해석

나인플러스 EDA (주)                                   85

5) Run PSpice

Rbreak 소자를 선택한 후 마우스 오른쪽 버튼을 눌러 Edit PSpice Model 메뉴를 선택하고

DEV=5% TC1=5e-4 TC2=0를 입력한다.

 저장하고 메뉴의 Model > Copy From...을 실행

 New Model에 Rmonte를 입력하고 From Model의 

Rbreak를 클릭한 다음 OK 버튼을 클릭한다.

DEV=10%로 변경하고 저장한 다음 Model Editor를 빠져 나간다. Run PSpice를 수행한다.
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 Trace > Performance Analysis... 메뉴를 실행한다.

     

V(out) 노드의 전압 값을 측정해 보기 위해 Max 함수를 이용하여 분석한다.

    

정상인 경우의 Max 값이 나타난다.
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Rbreak 소자의 Tolerance를 이용한 몬테카를로 해석을 수행한 결과이다.

빨간 네모 영역 안에 샘플 수, 편차, 중간 값, 평균값, 최대값, 최소값 등의 정보가 있다.

n samples : 실행 횟수 sigma : 편차 median : 중간 값

n divisions : 막대그래프 수 minimum : 최소 값 90th %ile : 90%일 때의 값

mean : 평균값 10th %ile : 10%일 때의 값 maximum : 최대 값
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과 제  - Source 전원변동에 의한 영향에 대해 Tran, Param, Monte-Carlo 해석수행

V1

TD = 1m

TF = 1n
PW = 10m
PER = 20m

V1 = 0

TR = 1n

V2 = 10v

R1

Rmonte
10k

R2

Rmonte
{Rdown}

R3

Rmonte
{Rup}

R4

Rmonte
100kCbreak

C1

0.1u

V2

{VDC}

IN
U1 uA741

+
3

-
2

V+
7

V-
4

OUT
6

OS1
1

OS2
5

OUT

0

PARAMETERS:
Rdown = 6.3
Rup = 3.7
VDC = 10V

V

V

입력 V(in)의 Rise-Edge Trigger가 발생하면 입력에 대해 1㎳의 Delay된 출력 V(out)를 발생

하는 펄스 발생기이다. Delay의 설계 공차는 상한치 1.1㎳, 하한치 0.9㎳로 한다.

1. 전압의 변동 량에 따른 출력 변화를 측정하고 전압의 변동량에 의한 출력 V(out)의 영향

을 판단한다. 전압의 변화량은 ±5%이고 Parametric Analysis를 통한 분석을 하시오.

2. 커패시터 C1과 저항 R1의 오차에 의해 나타나는 출력 V(out)의 영향을 측정하시오

C1 : DEV = 5%, R1 : DEV = 10%

Monte-Carlo 해석을 수행하고 반복횟수는 100, Distribution은 Uniform으로 설정한다.

해  설

시뮬레이션 결과 Delay 1㎳발생
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 - 과도해석

  - Monte Carlo 해석

 - Parametric 해석

 - Time + Monte 해석
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11
ABM 소자 활용

1. ABM(Analog Behavioral Modeling)

ABM 라이브러리는 전자소자 혹은 전자시스템의 동작 상태를 전달함수나 혹은 Look-up 

Table 등을 통하여 기술할 수 있는 기능을 가지고 있는 소자이다. 임의의 회로를 실제 전기

적인 소자를 이용하여 설계하지 않고도 회로의 동작 상태를 수학적인 표현으로 기술하여 검

증할 수 있다.

2. ABM 모델 종류

1) 기본소자

기본 소자는 산술적 계산을 할 수 있는 ABM 소자이고 입출력 전압의 기준점은 아날로그 

접지단자이다.

소자이름 소자 심벌 기능 표현식 출력값 입력갯수 출력갯수

CONST OUT1.000
Output=Constant 실수 값 0 1

SUM
IN1

OUTIN2
Output=Input+Input 두 입력의 합 2 1

MULT
IN1

IN2 OUT Output=Input*Input 두 입력의 곱 2 1

GAIN 1E3 Output=Gain*Input 입력의 증폭 값 1 1

DIFF
IN1

OUTIN2
Output=Input-Input 두 입력의 차 2 1

2) Limiters

출력 전압의 크기를 최저 값, 최고 값으로 제한하는 기능을 갖는 소자들이다. 입∘출력 단자

의 기준은 아날로그 접지 단자이다.
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소자 

이름
소자 심벌 기    능

정의해야할 변수 입력 

갯수

출력 

갯수LO HI Gain

LIMIT IN
OU
T

10

0

출력 전압의 크기를 최저값(LO), 최

고값(H)으로 제한하는 기능을 갖고 

있다. 출력전압의 크기가 최저, 최고

값 사이에 있을 경우 입력전압에 일

대 일 대응한다.

O O 1 1

GLIMIT IN OU
T1k

10

0

증폭기능을 갖고 있는 LIMIT이다. 출

력전압은 LIMIT 기능과 동일하되 입

력 전압을 증폭하는 기능을 갖고 있

다.

O O O 1 1

SOFTLIM IN

OU
T

1k10

0

LIMIT와 같은 기능을 갖고 있되 출

력전압은 입력전압의 tanh 값으로 

계산된다.

O O 1 1

3) 수학적인 연산자

입력전압을 다른 형태의 전압신호로 변환하기 위하여 사용할 수 있는 소자이다. 삼각함수 

값에 해당되는 소자를 이용할 경우 주어진 입력값은 rad/sec로 인식된다.

소자이름 소자 심벌 기능 표현식 출력값
입력

갯수

출력

갯수

ABS OUTINABS
Output=|Input| 입력의 절대값 1 1

LOG IN OUTLOG Output=log (Input) 입력의 자연대수 값 1 1

LOG10 IN OUTLOG10 Output=log (Input) 입력의 상용대수 값 1 1

EXP IN OUTEXP
Output= 입력의 지수값 1 1

SQRT IN OUTSQRT
Output= 입력의 제곱근 값 1 1

PWR IN OUT1.0PWR
Output=Exp 입력 절대값의 X 제곱값 1 1

PWRS IN OUT1.0PWRS
Output=Exp 입력의 X 제곱값 1 1

SIN IN OUTSIN
Output=sin(Input) 입력의 sine 값 1 1

COS IN OUTCOS
Output=cos(Input) 입력의 cosine 값 1 1

TAN IN OUTTAN
Output=tan(Input) 입력의 tagent 값 1 1

ARCTAN IN OUTARCTAN
Output=tan   입력의 arctagent 값 1 1

ATAN IN OUTATAN
Output=tan   입력의 arctagent 값 1 1
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4) 미분기 및 적분기

입력 신호를 미분/적분할 수 있는 소자이다.

소자이름 소자 심벌 기능 표현식
변수 입력

갯수

출력

갯수Gain 초기값

DIFFER
d/dt
IN OUT

1.0
Output= 


O 1 1

INTEG
0V

1.0 Output=  O O 1 1

여기에서 IC 값은 초기 전압 값을 의미한다.

5) 필터(Filters)

필터를 설계하기 위하여 사용되는 필터 함수는 여러 종류가 있지만, ABM에서 사용되는 기

본 필터구조는 Chebyshev 형태이다. Chebyshev 필터함수는 통과대역에서 맥동 Ripple이 나

타나는 것이 특징이며 차단주파수(Cutoff Frequency)는 맥동폭을 빠져나가는 주파수가 된다. 

이는 Butterworth 형태의 필터함수에서 차단주파수를 최대이득에서 -3dB 감쇄되는 주파수로 

정의되는 것과 다르다.

소자이름 소자심벌 기  능
정의해야 할 변수

Ripple FP FS STOP F0 F1 F2 F3

LOPASS
IN OUT

100Hz
10Hz 1dB

50dB

저역통과필터 O O O O

HIPASS
IN OUT

100Hz
10Hz 1dB

50dB

고역통과필터 O O O O

BANDPASS
1dB 50dB

10Hz
100Hz
300Hz

1000Hz

대역통과필터 O O O O O O

BANDREJ
1dB 50dB 10Hz

100Hz
300Hz

1000Hz

대역저지필터 O O O O O O

아래 표는 필터의 기능을 정의하기 위하여 사용되는 변수에 대한 설명이다.
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소자 심벌 변 수 의      미

LOPASS

RIPPLE 통과대역에서의 맥동크기의 dB 값

FP 통과대역이 끝나는 차단주파수를 Hz 단위로 표현

FS 통과대역에서 특정주파수를 의미하며 Hz 단위로 표현

STOP FS 주파수에서 최소의 감쇄크기를 dB 값으로 표현

HIPASS

FS 통과금지대역에서 특정주파수를 Hz로 표현

STOP FS 주파수에서 최소의 감쇄크기를 dB값으로 표현

FP 통과대역이 시작되는 차단주파수를 Hz로 표현

RIPPLE 통과대역에서의 맥동크기의 dB 값

BANDPASS

F0 통과금지대역에서 저역의 특정주파수를 Hz로 표현

F1 대역통과가 시작되는 저역 차단주파수를 Hz로 표현

F2 대역통과가 끝나는 고역 차단주파수를 Hz로 표현

RIPPLE 통과대역에서의 맥동크기의 dB 값

F3 통과금지대역에서 고역의 특정주파수를 의미하며 Hz로 표현

STOP F0 및 F3 주파수에서 최소 감쇄크기를 dB 값으로 표현

BANDREJECT

RIPPLE 저역, 고역통과대역에서의 맥동의 크기를 dB 값으로 표현

F0 저역 통과대역이 끝나는 차단주파수를 의미하며 Hz로 표현

F1 통과금지대역에서 특정주파수를 의미하며 Hz로 표현

STOP F1 및 F2 주파수에서 최소 감쇄 크기를 dB 값으로 표현

F2 통과금지대역에서 특정주파수를 의미하며 Hz로 표현

F3 고역 통과대역이 시작하는 주파수를 의미하며 Hz로 표현

6) S-영역에서의 전달함수

선형시스템의 입∘출력관계는 s-영역에서 전달함수 H(s)로 표현 가능하며, 수식은 아래와 같

다.

   

  

여기서 Vi(s) 및 Vo(s)는 전압 혹은 전류 중 각기 한 개의 변수를 의미한다.

소자 이름 소자 심벌 기     능 정의해야 할 변수

LAPLACE IN OUT1
1 + s

S-영역에서의 전달함수
분자항(NUM)

분모항(DENOM
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7) Table 형태의 데이터

소자 

이름
소자 심벌 기   능

정의해야 

할 변수

TABLE
IN      OUT
IN OUT

0V        0V
1V        1V
2V        4V
3V        9V
4V        16V

TABLE

입력전압에 대한 출력전압의 관계를 Table 

화 시킬수 있는 기능을 가진 소자이다. 입

력과 출력의 관계를 최대 5개까지 정의할 

수 있으며, 정의되지 않은 입∘출력전압관계

는 두 값 사이를 선형적으로 계산하여 값을 

결정하게 된다. 입력전압이 5번째 열에 정

의된 값보다 큰 값일 경우 출력 값은 출력

에 정의된 최대값으로 포화된다. 제1열에서 

정의된 입력전압 이하의 전압이 인가될 경

우 출력전압은 제1열에서 정의된 출력전압

에 포화된다. 이 소자는 DC SWEEP, 

TRANSIENT 해석에서 사용이 가능하며, AC 

SWEEP에서는 사용할 수 없다.

ROW1...

ROW5

FTABLE
freq     dB     deg
IN OUT

0Hz         0         0
10Hz      -3       -30
20Hz      -6       -90
30Hz     -10      -120
40Hz     -15      -150

FTABLE 주파수 성분에 따른 출력신호의 크기 및 위

상을 정의할 수 있다. 정의되지 않는 주파

수 성분에 대한 크기 및 위상 값은 정의된 

두 성분 값을 이용하여 선형적으로 계산하

여 출력 값을 결정한다. 이 소자는 AC 

SWEEP에 사용할 수 있는 소자이다.

ROW1...

ROW5
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8) 기능표현 소자

입∘출력 전압 혹은 전류관계를 수학적인 표현을 통하여 관계식을 정립할 수 있는 소자이다.

소자이름 소자 심벌 기능 설명
출력 

형태

ABM OUT
3.14159265

출력 값은 3.14159265 전압

ABM1
OUTIN

(V(%IN) * 100)/1000

 

  
전압

ABM2

IN1

IN2
OUT

( V(%IN1)+V(%IN2) ) / 2.0

 

   
전압

ABM3

IN1
IN2
IN3

OUT

( V(%IN1)
+V(%IN2)
+V(%IN3) ) / 3.0

 

     
전압

ABM/I
OUT+
OUT-

1.4142136 출력 값은 1.4142136 전류

ABM1/I

OUT+

OUT-
IN

(V(%IN) + 100) / 1000

 

  
전류

ABM2/I

IN1

IN2

OUT+

OUT-
(V(%IN1) + V(%IN2)) / 2.0

 

  
전류

ABM3/I

IN1
IN2
IN3

OUT+

OUT-
(V(%IN1)
+V(%IN2)
+V(%IN3)) / 3.0

 

     
전류
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9) 전압제어 전압/전류원

구분 소자 이름 소자 심벌 기  능 함수 및 관계식

수학적인 

표현소자

EVALUE
IN+
IN-

OUT+
OUT-

E1

V(%IN+, %IN-)
EVALUE

출력 값은 정의된 수식

을 이용하여 입력신호 

값을 결정한다.

EVALUE :

전압제어용 전압원

GVALUE : 

전압제어용 전류원

ABS TAN

SQRT ATAN

EXP SINH

LOG COSH

GVALUE IN-
OUT+
OUT-

IN+
G1

V(%IN+, %IN-)
GVALUE

LOG10 TANH
PWR MIN
PWRS MAX
SIN LIMIT
ASIN SGN
COS STP
ACOS IF

ESUM

IN1+
IN1-

IN2+
IN2-

OUT-

OUT+

E2

ESUM

두 입력신호의 합으로 

출력 값을 결정한다.

ESUM :

전압제어용 전압원이며 

기준전압은 ‘-’로 표현

되는 단자이다.

GSUM :

전압제어용 전류원이며 

방향은 위에서 아래이

다.

V(OUT+, OUT-) =

V(IN+, IN-)+V(IN2+, IN-)

GSUM
OUT+

OUT-IN2-

IN1-

IN2+

IN1+
G2

GSUM I=V(IN+, IN-)+V(IN2+, IN-)

EMULT

IN1+

IN2+

IN1-

IN2-
OUT-

OUT+

E3

EMULT

두 입력신호의 곱으로 

출력 값을 결정한다.

EMULT :

전압제어용 전압원이며 

기준전압은 ‘-’로 표현

되는 단자이다.

GMULT :

전압제어용 전류원이며 

방향은 위에서 아래이

다.

V(OUT+, OUT-) =

V(IN+, IN-)*V(IN2+, IN-)

GMULT

IN1+

IN2+

IN1-

IN2- OUT-

OUT+
G3

GMULT I=V(IN+, IN-)*V(IN2+, IN-)

Look-up 

Table

ETABLE
IN+
IN-

OUT+
OUT-

E4

V(%IN+, %IN-)
ETABLE

입∘출력관계를 table화 

시킬 수 있는 소자이다. 

변수 TABLE을 이용하

여 정의할 수 있다.

ETABLE :

전압제어용 전압원

GTABLE : 

전압제어용 전류원

TABLE

GTABLE IN-
OUT+
OUT-

IN+
G4

V(%IN+, %IN-)
GTABLE
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구분 소자 이름 소자 심벌 기  능 함수 및 관계식

Frequency 

Look-up

Table

EFREQ IN-
OUT+
OUT-

IN+
E5

V(%IN+, %IN-)
EFREQ

입∘출력의 주파수 응답 관계를 

table화 시킬 수 있는 소자이다. 

변수 TABLE을 이용하여 주파수 

성분, 크기 및 위상을 정의할 수 

있으며, AC Sweep 해석 시에만 

사용가능하다.

EFREQ :

전압제어용 전압원

GFREQ : 

전압제어용 전류원

TABLE

DELAY

R_I

MAGUNITS

PHASEUNITSGFREQ
IN+
IN-

OUT+
OUT-

G5

V(%IN+, %IN-)
GFREQ

Laplace 

Look-up

Table

ELAPLACE IN-
OUT+
OUT-

IN+
E6

V(%IN+, %IN-)
ELAPLACE

입∘출력사이의 전달함수를 정의할 

수 있는 소자이다. AC Sweep 및 

Transient 해석에서 사용할 수 있

다.

ELAPLACE :

전압제어용 전압원

GLAPLACE : 

전압제어용 전류원

XFORM

GLAPLACE IN-
OUT+
OUT-

IN+
G6

V(%IN+, %IN-)
GLAPLACE
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따라하기

1) 회로도 - 실효값(Root Mean Square Value)

V1

FREQ = 1k
VAMPL = 1
VOFF = 0

IN-
OUT+
OUT-

IN+
G1

V(%IN+, %IN-)*V(%IN+, %IN-)

GVALUE
C1
1

R1
1G

IN+
IN-

OUT+
OUT-

E1
IF(TIME<=0,0,SQRT(V(INT)/TIME))

EVALUE
R2
1k

0

IN
INT

OUT

2) 사용기능 및 부품

(Place Part)VSIN, EVALUE, GVALUE, R, C,  (Place Ground)GND

(Place Wire), (Place Net Alias)

3) 시뮬레이션 조건
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4) Probe 설정

V1

FREQ = 1k
VAMPL = 1
VOFF = 0

IN-
OUT+
OUT-

IN+
G1

V(%IN+, %IN-)*V(%IN+, %IN-)

GVALUE
C1
1

R1
1G

IN+
IN-

OUT+
OUT-

E1
IF(TIME<=0,0,SQRT(V(INT)/TIME))

EVALUE
R2
1k

0

IN
INT

OUT

V
I
I V

5) Run PSpice

           Time
0s 0.5ms 1.0ms 1.5ms 2.0ms 2.5ms 3.0ms 3.5ms 4.0ms 4.5ms 5.0ms

V(IN) V(OUT) I(G1) -I(G1)
-1.0

-0.5

0

0.5

1.0

Add Plot 명령으로 Plot Window를 추가해 전류원측과 전압원측으로 분리한다.

           Time
0s 0.5ms 1.0ms 1.5ms 2.0ms 2.5ms 3.0ms 3.5ms 4.0ms 4.5ms 5.0ms

V(IN) V(OUT)
-1.0V

0V

1.0V
I(G1) -I(G1)

-1.0A

0A

1.0A

SEL>>
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①           ②        ③

V1

FREQ = 1k
VAMPL = 1
VOFF = 0

IN-
OUT+
OUT-

IN+
G1

V(%IN+, %IN-)*V(%IN+, %IN-)

GVALUE
C1
1

R1
1G

IN+
IN-

OUT+
OUT-

E1
IF(TIME<=0,0,SQRT(V(INT) /TIME))

EVALUE
R2
1k

0

IN
INT

OUT

① 입력 신호를 제곱할 수 있는 기능을 모델링

② 시간에 따라 제곱된 값을 적분할 수 있는 기능을 가진다.

③ 계산된 값의 평균값을 취한 후 제곱근을 구할 수 있는 기능을 모델링(EVALUE)

IF(TIME<=0,0,SQRT(V(INT)/TIME)) : 두 입력차를 이용하여 TIME이 0보다 작거나 같으면 0, 

크면 SQRT(V(INT)/TIME)을 출력하는 회로

IF(TIME>0,(SQRT(V(INT)/TIME)),0) : 두 입력차를 이용하여 TIME이 0보다 크면 

SQRT(V(INT)/TIME), 아니면 0을 출력하는 회로

정현파 실효값

 



 







전압제어용 전류원인 G1은 입력 신호를 제곱하는 역할을 하게 되며, 제곱된 입력 신호는 커

패시터 C1에 의해 적분된다. 저항 R1의 역할은 DC 바이어스 계산 시 전류가 흐를 수 있도

록 하는 역할만을 하게 된다. 전압제어용 전압원인 E1은 적분된 값의 평균값을 구한 후 제

곱근을 구하는 소자이다. 입·출력과의 관계식은 IF 문을 사용하여 정의하였다. IF 문에 사용

될 수 있는 조건은 수학적인 기호로 표현한다. 

다음은 IF 문에서 사용할 수 있는 수학적인 기호 및 조건을 나열한 것이다.

기호 조건 기호 조건

== equal < less than

!= not equal <= less than or equal to

> greater than

>= greater than or equal to
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과 제  - 두 입력차를 이용한 0, 5V 출력회로

두 입력차가 0보다 작으면 0, 크면 5를 출력하는 회로를 다음 조건을 이용하여 구성하고 시

뮬레이션하시오

EVALUE : +단자(VPULSE), -단자(VSIN)

VPULSE : V1=0v, V2=5v, TD=0㎳, TR=4.8㎲, TF=0.1㎲, PW=0.1㎲, PER=5㎲

VSIN : VOFF=0v, VAMPL=2v, FREQ=10㎑

해  설

V1

TD = 0ms

TF = 0.1us
PW = 0.1us
PER = 5us

V1 = 0v

TR = 4.8us

V2 = 5v
V2

FREQ = 10kHz
VAMPL = 2v
VOFF = 0v

R1

1k
R2

1Meg

IN+
IN-

OUT+
OUT-

E1

IF(V(%IN+, %IN-)<0,0,5)
EVALUE

PUL

0 0 0

SIN
OUT

V
V

V
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12
Stimulus Editor 활용

1. 화면구성

2. Toolbar

① ② ③  ④  ⑤ ⑥ ⑦ ⑧ ⑨              
① New : Stimulus 생성하기

② Open : Stimulus 열기

③ Save : Stimulus 저장

④ Print : Stimulus 프린트 출력

⑤ Zoom In : 화면 확대

⑥ Zoom Out : 화면 축소

⑦ View Area : 영역 확대

⑧ View Fit : 화면에 맞게 확대

⑨ Axis Settings : 축 설정

 New Stimulus : Stimulus 파형 만들기
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 Get Stimulus : 파형 가져오기

 Edit Attributes : 파형 속성 편집

 Add : Cursor 포인트 추가

 Digital Value : 트랜지션 추가 시 사용할 Digital Value

3. Stimulus 전원 종류

Stimulus Editor는 Transient analog와 digital sources를 정의하는 그래픽적인 방법을 제공한

다.

심볼명 부품모양 속  성 의   미 용   도

VSTIM S
V1

Implementation =

Implementation :
신호원 명칭

아날로그 전압원
Stimulus를
이용한
아날로그 입력용

ISTIM S
I1

Implementation =

Implementation :
신호원 명칭

아날로그 전류원
Stimulus를
이용한
아날로그 입력용

DigStim1 S1
DSTM11

Implementation =

Implementation :
신호원 명칭

디지털 1 Signal
클럭 입력원

Stimulus를
이용한
디지털 입력용

DigStim2

DigStim4

DigStim8

DigStim16

DigStim32

S2
DSTM12

Implementation =

S4
DSTM13

Implementation =

S8
DSTM14

Implementation =

S16
DSTM15

Implementation =

S32
DSTM16

Implementation =

Implementation :
신호원 명칭

디지털 2 bit
클럭입력원

디지털 4 bit
클럭 입력원

디지털 8 bit
클럭 입력원

디지털 16 bit
클럭 입력원

디지털 32 bit
클럭 입력원

Stimulus를
이용한
디지털 입력용
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따라하기

1) 회로도

U1

LF411

+
3

-
2

V+
7

V
-

4

OUT
6

B1
1

B2
5

R1

1k

R2
1k

R3

1k

R4

1k

R5
1k

C1
1n

C2
{Cvar}

S
V1

MYPULSE

V2
15Vdc

V3
-15Vdc

0 0

0

0
VDD VSS

VSS

VDD
0

PARAMETERS:
Cvar = 1n

2) 사용기능 및 부품

(Place Part)VSTIM, R, C, LF411, PARAM     (Place Ground)GND

(Place Wire)     (Place Net Alias) (Place Off-page connector)

3) 시뮬레이션 조건
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4) Probe 설정

U1

LF411

+
3

-
2

V
+

7
V

-
4

OUT
6

B1
1

B2
5

R1

1k

R2
1k

R3

1k

R4

1k

R5
1k

C1
1n

C2
{Cvar}

S
V1

MYPULSE

0

0
0

0 0

V2
15Vdc

V3
-15Vdc

VDD VSS

VSS

VDD

PARAMETERS:
Cvar = 1n I

5) Stimulus 설정
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6) Run PSpice

           Time
0s 0.5us 1.0us 1.5us 2.0us 2.5us 3.0us 3.5us 4.0us 4.5us 5.0us

... I(C2)
-100uA

0A

100uA

200uA
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Plot에서 Add Plot to Window 실행 → Trace에서 Add Trace 실행

I(C2)@25- I(C2)@1 입력

           Time
0s 0.5us 1.0us 1.5us 2.0us 2.5us 3.0us 3.5us 4.0us 4.5us 5.0us

... I(C2)
-200uA

0A

200uA
I(C2)@25- I(C2)@1

-200uA

0A

200uA

SEL>>

 Performance option

Trace → Performance Analysis → Wizard
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           Time
0s 0.5us 1.0us 1.5us 2.0us 2.5us 3.0us 3.5us 4.0us 4.5us 5.0us

... I(C2)
-200uA

0A

200uA
           Cvar

100p 200p 300p 400p 500p 600p 700p
Max(I(C2))

0

100u

200u

SEL>>
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과 제  - 3상 성형 정류회로

VSTIM 소자를 이용하여 Phase = 0, 120, 240을 다상회로에 D1N4148을 추가하여 3상 성형 

정류기를 구성하고 시뮬레이션 하시오. [V(out), RMS(V(out)) 측정]

해  설

S

V1

Implementation = P0

S

V2

Implementation = P120

S

V3

Implementation = P240

D1

D1N4148

D2

D1N4148

D3

D1N4148

OUT

R1
1k

0 0V

V

V

V

 

P0의 파형 정보 P120의 파형정보 P240의 파형정보
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Add Trace 후 RMS 측정

 또는 
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13
Digital 회로

1. 논리회로

디지털 시스템의 기본 논리회로는 AND, OR, NOT Gate와 Flip-Flop 등으로 구성되어 있다. 

이들 회로의 입력과 출력의 기준은 1 또는 0으로 표시하며 이것을 전압의 고저로 나타낸다.

2. 디지털회로 Simulation을 위한 설정

1) 디지털 신호 상태 종류

‘0’ : Low ‘1’ : High
'F' : Falling 'R' : Rising
'X' : Unknown 'Z' : High Impedance

2) Syntax

<digital_node_name>;<display_name> or <digital_expression>;<display_name>

예) U2:Y;OUT1

{digital signals list};display name;radix or {bus_prefix[msb:lsb]};display name;radix

예) {Q2 Q1 Q0};A;O[B,D,H],    {a3 a2 a1 a0};;d

B : Binary,    D : Decimal,    O : Octal,   H or X : Hexadecimal(Default)
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3) Digital Operator

(  ) grouping

~ logical complement

* / multiplication/division (bus values only)

+ - addition/subtraction (bus values only)

& and

^ exclusive or

| or

4) 디지털 전원

      

5) Timing Mode

0 시뮬레이션 프로파일에 정의된 기본값. Options → Gate level simulations
1 Minimum Delay
2 Typical Delay
3 Maximum Delay
4 Worst Case Analysis

U2A

7404

MNTYMXDLY = 4

1 2data data+delayS1
DSTM1

COMMAND1 = 0s 1
COMMAND2 = 40ns 0

V V
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Input Output
EI D7 D6 D5 D4 D3 D2 D1 D0 GS Q2 Q1 Q0 EO
0 X X X X X X X X 0 0 0 0 0
1 0 0 0 0 0 0 0 0 0 0 0 0 1
1 1 X X X X X X X 1 1 1 1 0
1 0 1 X X X X X X 1 1 1 0 0
1 0 0 1 X X X X X 1 1 0 1 0
1 0 0 0 1 X X X X 1 1 0 0 0
1 0 0 0 0 1 X X X 1 0 1 1 0
1 0 0 0 0 0 1 X X 1 0 1 0 0
1 0 0 0 0 0 0 1 X 1 0 0 1 0
1 0 0 0 0 0 0 0 1 1 0 0 0 0

따라하기

1) 회로도

U1

CD4532B

V
S

S
8

V
D

D
16

D7
4

D6
3

D5
2

D4
1

D3
13

D2
12

D1
11

D0
10

EI
5

Q2
6

Q1
7

Q0
9

EO
15

GS
14

CLK
DSTM1OFFTIME = .5uS

ONTIME = .5uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

CLK
DSTM2OFFTIME = 1uS

ONTIME = 1uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

CLK
DSTM3OFFTIME = 2uS

ONTIME = 2uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

CLK
DSTM4OFFTIME = 4uS

ONTIME = 4uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

Q0

Q2

Q1

V1
12Vdc

0

VDD

VDD

0

Q[0:2]

2) 사용기능 및 부품

(Place Part)CD4532B, VDC, Digclock(Source.olb), (Place Ground)GND

(Place Wire), (Place Bus), (Place Net Alias)

3) 시뮬레이션 조건

 

※ 진리표
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           Time           Time0s 5us 10us 15us 20us 25us 30us 35us 40us 45us 50us

  DSTM1:1
  DSTM2:1
  DSTM3:1
  DSTM4:1
       Q0
       Q1
       Q2
 {Q[0:2]} 1 6 2 1 6 2 1 6 2 1 6 2 1 6 2 1 6 2 1

4) Probe 설정

U1

CD4532B

V
S

S
8

V
D

D
16

D7
4

D6
3

D5
2

D4
1

D3
13

D2
12

D1
11

D0
10

EI
5

Q2
6

Q1
7

Q0
9

EO
15

GS
14

CLK
DSTM1OFFTIME = .5uS

ONTIME = .5uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

CLK
DSTM2OFFTIME = 1uS

ONTIME = 1uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

CLK
DSTM3OFFTIME = 2uS

ONTIME = 2uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

CLK
DSTM4OFFTIME = 4uS

ONTIME = 4uS
DELAY = 0
STARTVAL = 0
OPPVAL = 1

Q0

Q2

Q1

V1
12Vdc

0

VDD

VDD

0

Q[0:2]

V

V

V

V

V

V

V

V

5) Run PSpice

버스 신호 표현법으로는 {MSB ••••••••• LSB} 또는 {Bus_Name[MSB:LSB]}

예) {Q2 Q1 Q0} 또는 {Q[2:0]} 또는 {Q[0:2]}
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과 제  - 반가산기 Delay Time 구하기

사용할 소자 : 7486, 7400을 이용하여 반가산기를 구성하고 시뮬레이션 하시오.

입력 신호는 0.2㎲ 간격으로 00, 01, 10, 11, 00, 01, 10, 11, …를 인가하시오.

각 Transition이 일어나는 부분의 Delay Time을 조사하시오.

해  설

U1A

7486

1
2 3

U2A

7408

1

2
3 CARRY

SUMCLK
AOFFTIME = .4uS

ONTIME = .4uS
DELAY =
STARTVAL = 0
OPPVAL = 1

CLK
BOFFTIME = .2uS

ONTIME = .2uS
DELAY =
STARTVAL = 0
OPPVAL = 1

A

B

V

V

V

V
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A
관련사항

1. 임피던스

순수 저항소자에 있어서의 저항 값은 저항이라고 하지만 포괄적인 의미의 저항을 임피던스

라고 한다. 즉 콘덴서, 코일, 저항을 포함하여 교류에 대한 저항을 말한다.

구  분 임피던스 저 주 파 고 주 파

저 항  일정 일정

코 일    저항 작아짐 저항 커짐

콘 덴 서 





저항 커짐 저항 작아짐

  : s 파라미터,        : 각 주파수

2. 데시벨(dB)

현재의 음량이 인간의 귀가 어느 정도 크기로 느끼는지를 수치적으로 표시하기 위해 만든 

단위이다. 예로 실제 음량을 기준 음량대비 100배로 올리면 인간의 귀는 대수적으로 취한 

즉 2배 정도 증가한 것으로 느낀다.

전력데시벨 :   log


  :  : 기준값(입력 기준값),  : 비교값(출력 측정값)

전압데시벨 :   log



전류데시벨 :   log


  log


dBm : 임피던스 600Ω에서 1mW를 소비할 때의 전압을 기준하여 나타낸 데시벨
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배수 전력[dB] 전압, 전류[dB]

1/100 -20[dB] -40[dB]

1/10 -10[dB] -20[dB]

1/4 -6[dB] -12[dB]

1/2 -3[dB] -6[dB]

1/ -1.5[dB] -3[dB]

1 0[dB] 0[dB]

 1.5[dB] 3[dB]

2 3[dB] 6[dB]

4 6[dB] 12[dB]

10 10[dB] 20[dB]

100 20[dB] 40[dB]

3. S/N 비

신호 대 잡음 비를 의미하며 그 값이 클수록 잡음이 적은 기기라고 볼 수 있다.

  log




  : 신호성분 실효치,    : 노이즈성분 실효치

4. Bode Plot

회로 혹은 시스템의 Frequency Response를 그래프화 한 것으로 주파수축에 대한 이득

(Gain)특성과 위상특성을 표기한 것이다. 이 때 입력 측에 인가하는 신호의 형태는 크기는 

고정되어 있고 주파수만 저주파에서 고주파 부분까지 Sweep하는 형태를 갖고 있다.

전달함수를 주파수 응답에 대한 크기와 위상으로 표현하는 것을 말한다. 회로에 들어가는 

입력신호는 주파수에 따라서 크기와 위상이 변화하는 사인파의 합으로 적용한다.



나인플러스 EDA (주)                                   118

B
예제회로

Common Emitter Amplifier

- VSIN, R, C, Q2N2222, VDC, GND(Place Ground)

Vsig

FREQ = 10k
VAMPL = 1mV
VOFF = 0

R1

1k

RB1

49k

RB2

27k
RE

1.8k

RC
5k

RL
1k

C1

3u

CE

75u

CC

4uQ1

Q2N2222

VDC

5V

in

out

0
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Common Emitter Amplifier

- VSIN, R, C, Q2N2222, VDC, GND(Place Ground)

Vsig

FREQ = 10k
VAMPL = 1mV
VOFF = 0

AC = 1

R1

1k

RB1

49k

RB2

27k
RE

1.8k

RC
5k

RL
1k

C1

3u

CE

75u

CC

4uQ1

Q2N2222

VDC

5V

in

out

0

VDB
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Add Trace 버튼을 눌러 Noise 관련식을 입력한다.

  

Y축을 하나 추가시켜 Noise 그래프를 이동시킨다.

Trace Expression : SQRT(NTOT(ONOISE)*NTOT(ONOISE));Noise_Figure
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Common Emitter Amplifier

- VSIN, R, C, Q2N2222, VDC, PARAM, GND(Place Ground)

Vsig

FREQ = 10k
VAMPL = 1mV
VOFF = 0

R1

1k

RB1

49k

RB2

27k
RE

1.8k

RC
{Rvar}

RL
1k

C1

3u

CE

75u

CC

4uQ1

Q2N2222

VDC

5V

in

out

0

PARAMETERS:
Rvar = 5k

V

  

 저항값 Parameter Sweep



나인플러스 EDA (주)                                   123

 Model 속성 Bf Sweep

 온도 Sweep
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Common Emitter Amplifier

회로에서 저항들만을 선택한 다음 Enter키나 마우스 오른쪽 버튼을 눌러 Edit Properties를 

실행시켜 Tolerance 부분에 아래와 같이 오차범위를 지정한다.
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다음 Performance Analysis 과정을 통해 Monte-Carlo 통계해석을 수행한다.
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C
시뮬레이션 시 Error 대책

1. Unmodeled parts

Warning : Part Part_name has no simulation model.

 Place Part에서 왼쪽 그림처럼 PSpice 아이콘 모양이 있는 라이브러리를 사용

해야 시뮬레이션이 가능하다.

2. Missing Ground

ERROR -- Node node_name is floating

(X)      (O)

Source.olb의 0 ground 부품을 반드시 사용해야 한다. 또는 Wire에 Net Alias로 0을 설정해

야만 시뮬레이션이 가능하다.
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3. Missing DC path to ground

DC 해석시 병렬 Capacitor가 Open 해석되기 때문에 전압원-인덕터를 연결한 경우 직렬 인

덕터에는 작은 저항(0.01이하)을 직렬로 연결하고, 전류원-캐패시터를 연결한 경우 병렬 캐

패시터에 큰 저항(1G이상)을 병렬로 연결한다.

4. User Defined Model parts

ERROR -- Model Model_name used by Model_Ref is undefined

사용자가 직접 구하거나 생성한 모델을 이용하여 시뮬레이션 할 경우 Library가 경로에 있

지 않아 특성을 불러오지 못하는 경우로 Simulation Profile에서 Library 경로에 추가시켜 줄 

필요가 있다.


